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1 Getting started
You have just installed SWAMIGO3, access control software, and through the different steps
in this document, you will be able to obtain all the necessary knowledge to operate it.

2 First launch of the software
The first time the software is launched, SWAMIGO3 asks you to select your language:

Select your language and then click on the button OK.
 You can also tick the « Don't call me back box » if you do not want SWAMIGO3 to ask you
for the language every time you start up

If you wish to display the language selection again at start-up, go to the menu Tools, then
Preferences and tick the box Asking for the language at startup.
If you wish to create a new installation, click on Yes when SWAMIGO3 asks you to do so.

3 Facilities management
After selecting your language, the following window appears:


-

This window allows you to :
Open an existing installation
Add a new installation
Changing the settings of an existing installation
Delete an existing installation
7

-

-

Backing up an existing installation
Restoring an installation from a backup file
Migrating an ACCESS database installation to a SQL SERVER database
View software help
Starting a remote help session
Request a forgotten password

Creation of a new installation
From the previous window, click Add.

From this window, select the type of installation:
If you are using only one PC :
- Select A Single User Installation (Access database).
If you using several PCs :




If you are installing SWAMIGO3 on the server workstation, select A client/server installation:
server workstation (SQL Server database).
 Warning : this station must remain permanently switched on.
If you are installing SWAMIGO3 on a client workstation, select A client/server installation: client
workstation (SQL Server database)

Click on Next

Single-user installation (ACCESS database):

 From this window :


Indicate the name of the installation



Indicate the location of the database. You can use the button
to display the tree structure
of your computer. The default directory is in the ProgramData folder in Windows.

Warning, if you modify this folder, make sure that SWAMIGO3 has read and write
access rights to it.


Change the image of the installation. To do this, click on the button Change

Client/server installation: server workstation (SQL server database) :

 From this window :


Indicate the name of the installation



Specify the path to your SQL server. You can use the
to display the list of SQL servers in
your network.
Indicate the name of your database (SWAMIGO3 by default)









Specify the authentication mode of your SQL server (Windows authentication - using the user
of the Windows session currently open on the computer - or SQL authentication - using the sa
or other login and password set during the installation of the SQL Server instance). If you do
not have a Windows domain and/or the user of the currently open Windows session is not
authorized on the database, please use SQL authentication.
Choose to use the Windows service: Allows you to close the Windows session of the computer
while keeping the dialogue with the control units active (example: for the use of global antipassback between several control units, the use of on-line automations, the control of Galaxy
HoneyWell intrusion control units - additional licence required in this case -, the use of
SWAMIGO3Web). If you use the Windows service, the use of SQL authentication is mandatory.
Choose to use SWAMIGO3Web if it is installed on your computer. In this case, the use of the
Windows service is mandatory.
Change the image of the installation. To do this, click on the button Change

Client/server installation: client workstation (SQL server database) :

 From this window :


Indicate the name of the installation



Specify the path to your SQL server. You can use the
to display the list of SQL servers in
your network. Warning, if you want to access a remote SQL Server instance (example: VPN
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connection or NAT rule), the automatic server search will not work. You will then have to
indicate the path to your database as follows: IP Address, Port (example: 192.168.1.1,1433).
Indicate the name of your database (SWAMIGO3 by default)
Specify the authentication mode of your SQL server (Windows authentication - using the user
of the Windows session currently open on the computer - or SQL authentication - using the sa
or other login and password set during the installation of the SQL Server instance). If you do
not have a Windows domain and/or the user of the currently open Windows session is not
authorized on the database, please use SQL authentication.
Change the image of the installation. To do this, click on the button Change

Click on Next

Server installation (ACCESS database or SQL Server) :

From this window and if you have the same type of reader for all your accesses, tick the option
Yes, I use the following reader type and select your player type from the list. This will save you
from having to set the player type for all the control units and extension modules in your
installation.
Click on Next.

Check all the information according to your previous settings and then click on Confirm
If the Windows service is used, a message will appear asking you to restart it. Then click on Yes
if applicable.

Changing the parameters of an existing installation
From the facility management window, select your facility and then click on Edit.

Case of an installation with an Access database :

 From this windows :





Rename the name of your installation. Be careful, this operation will not modify the name of
the directories used for your installation.
Enter the path of your installation. Note: make sure that the directory of your installation is
present in the new path before applying these modifications.
Activate the default installation: when SWAMIGO3 is started, the default installation will be
automatically launched after 30 seconds if no action is taken within this period of time.
Modify the installation image. To do this, click on the Modify button

Case of an installation with a SQL Server database :

 From this windows :
Indicate the name of your installation
Specify the path to your SQL Server instance. You can use the button to display the list of SQL Servers
in your network.
Activate the default installation: when SWAMIGO3 starts, the default installation will be automatically
launched after 30 seconds if no action is taken within this time.
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Indicate the type of installation among the choices Server workstation, Server workstation with
Windows service, Client workstation.
Indicate the name of your database (SWAMIGO3 by default).
Specify the authentication mode of your SQL server (Windows authentication - using the user of the
Windows session currently open on the computer - or SQL authentication - using the sa or other login
and password set during the installation of the SQL Server instance). If you do not have a Windows
domain and/or the user of the currently open Windows session is not authorized on the database,
please use SQL authentication.
Choose to use SWAMIGO3Web if it is installed on your computer. In this case, the use of the Windows
service is mandatory.
Change the image of the installation. To do this, click on the Modify button

Click OK to confirm the changes. If you are using the Windows service, a message will appear asking
you to restart it. Click Yes if necessary.

Removing an existing installation
From the installation management window, select the installation to be deleted and then click

on Delete.
Confirm the deletion by clicking Yes
If you are using an SQL Server database, you will be asked to confirm the deletion of the database
on your SQL instance. Click Yes if you are sure you want to delete the database.
If you are using the Windows service, a message will appear asking you to restart the Windows
service. Click Yes if necessary.
Warning: deletion will automatically destroy all the data present on your computer
concerning the selected installation. As it is impossible to re-read the parameters
contained in our control units, this operation is irreversible.
Make sure you have a backup before performing this operation.

Backing up an existing installation
From the facility management window, select the facility to be backed up and click on
Backup.

Choose the location of the backup file and then click on Save.

Fill in the password of the administrator of your installation then click on OK.

Make sure that you have write access privileges for the selected location.

Restoration of an installation
From the facility management window, click Restore.
Select the file to be restored in ZIP format and then click Open.

Restoring an installation with a SQL Server database :

 From this window :
Indicate the name of your installation
Specify the path to your SQL Server instance. You can use the button
Servers in your network.

to display the list of SQL

Activate the default installation: when SWAMIGO3 starts, the default installation will be automatically
launched after 30 seconds if no action is taken within this time.
Indicate the type of installation among the choices Server workstation, Server workstation with
Windows service, Client workstation.
Indicate the name of your database (SWAMIGO3 by default).
Specify the authentication mode of your SQL server (Windows authentication - using the user of the
Windows session currently open on the computer - or SQL authentication - using the sa or other login
and password set during the installation of the SQL Server instance). If you do not have a Windows
domain and/or the user of the currently open Windows session is not authorized on the database,
please use SQL authentication.
Choose to use SWAMIGO3Web if it is installed on your computer. In this case, the use of the Windows
service is mandatory.
Change the image of the installation. To do this, click on the Modify button
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Migration of an existing installation from an ACCESS database to
a SQL SERVER database
From the installation management window, select the Access database installation to be
migrated to SQL Server and then click Migrate to SQL.
The following message appears:

If you have not made a backup of your installation beforehand, click on No.
Make your backup (see previous chapter) and then repeat the operation.
If not, and to start the migration, click on « Migrate to SQL ».

 From this window :
Indicate the name of your installation
Specify the path to your SQL Server instance. You can use the button to display the list of SQL Servers in
your network.
Activate the default installation: when SWAMIGO3 starts, the default installation will be automatically
launched after 30 seconds if no action is taken within this time.
Indicate the name of your database (SWAMIGO3 by default).
Specify the authentication mode of your SQL server (Windows authentication - using the user of the
Windows session currently open on the computer - or SQL authentication - using the sa or other login
and password set during the installation of the SQL Server instance). If you do not have a Windows
domain and/or the user of the currently open Windows session is not authorized on the database,
please use SQL authentication.
Change the image of the installation. To do this, click on the Modify button

Click Migrate to SQL to start the migration.

Opening of an existing installation
From the facility management window, select the facility to be opened and click Open.

From this window, select the manager.
If the selected manager has protected his or her session with a password, enter the password.
Click OK.

Case of a first opening of an installation :
If you are opening an installation for the first time, SWAMIGO3 will ask you to enter the

Administrator Manager password as follows:
If you do not want to password protect the Administrator, click OK.
Otherwise, enter the password, confirm it and click OK.
We recommend that you set a password for the Administrator Manager, who
has unlimited access to the functions of the software.
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4 Menu management

Toolbar
Status
installation
Shortcuts

additional list of events

 From this window, you have several menus for operating the software. Throughout the
technical documentation, you will obtain the information you need to get to grips with
SWAMIGO3.

The toolbar

This toolbar represents all the functions of the software:
Technical: display of the entire configuration of the installation as well as the status of each
safety element (control units, extension modules, readers, etc.).
Schedules and access rights: management of user access rights, user access times, but also free
access (doors kept open), public holidays and special days (days that are not public holidays but
whose access times are different from the usual times).
Users: management of users accessing the installation as well as their identifiers (badges,
transmitters, codes, etc.), listing tool (creation of personalised lists of users according to
numerous configurable filters), calculation of attendance time and display of list of attendees.
Events: display of events that have occurred on the installation and history tool (creation of
personalised lists of events according to numerous configurable filters).
Synoptic: Creation of an interactive plan of the installation allowing to see and control the state
of the different elements in a graphic way.
Administration: Management of the different Managers authorised to access the SWAMIGO3
software and display of all their actions from a logbook.
To show or hide this bar, click on the View menu and then Toolbar.
 Tip: To hide this bar each time you start SWAMIGO3, go to the Tools menu,
Preferences, Configuration tab and uncheck the Show toolbar at startup box.

The status of the installation

This status makes it very easy to find out the overall status of the equipment in your
installation. The different statuses can be :
Active installation: No equipment faults. The installation is working properly.
Check your dongle: No equipment faults. However, no dongle is detected, which means that no update
of the control units or recovery of events can be done. This defect can occur if you use more than 2
readers on your installation and no control unit is equipped with a dongle.
Check the status of your equipment: At least one piece of equipment is not correctly connected. In this
case, open the equipment status from the Technical menu, Equipment status and then check the status
of all the equipment. At least one of them must have failed to connect or be disconnected.
Main workstation disconnected: In the case of a client/server installation, make sure that SWAMIGO3 or
the SWAMIGO3 service is launched on the server workstation. If this status is displayed, no update of
the control units or recovery of events is possible.
Problem accessing the database: the database is no longer accessible. Restart SWAMIGO3 and make
sure that the database is fully functional.
Check the status of your equipments (no dongle detected): At least one equipment is not correctly
connected. In this case, open the equipment status from the Technical menu, Equipment status and
then check the status of all the equipment. At least one of them must be in connection failure or
disconnected. Moreover, no dongle is detected. Very often with this status, the control unit carrying
the dongle is disconnected. Check the status of the dongle.
Presence time too long: a maximum presence time has been set in a zone, and a user has exceeded this
time.

Additional list of events

Two pieces of information can be displayed:
List of events
This list shows you all the events that have occurred on your installation since SWAMIGO3 was
started. It is always empty when the software is launched.
List of too long presence times
This list displays information about timeout in zones.
To close this list, click the Close button.
To view the list, click on View and then Event List.
 Tip: To hide this list each time SWAMIGO3 is started, go to the Tools menu,
Preferences, Configuration tab and uncheck the Show event list box.
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The status bar
 From this bar, you can :
-

Consult the security level of your installation. To modify it, click on it, then validate by OK.

View the name of the manager of the current session
Consult the software licence version (maximum number of readers allowed)
Consult the overall status of the equipment in your installation (see Installation Status above)
Check the connection status to the external server (available if external connections are enabled).
Enable or disable the sounds for each received event.
 Tip : to disable the sounds each time SWAMIGO3 is started, go to the Tools menu, Preferences,
Configuration tab and check the Disable sounds on startup checkbox.

To show or hide this bar, click on the View menu and then Status bar.

Shortcuts and remote control
Shortcuts
Shortcuts allow you to use a software function with a single click.
To show or hide the shortcuts, click on the View menu and then Shortcuts To hide the
shortcuts, you can also click on the Close button.
 Tip : To hide the shortcuts each time SWAMIGO3 is started, go to the Tools menu, Preferences,
Configuration tab and uncheck the Show shortcuts at startup box.

For more information, see the Shortcuts chapter.

The remote control

This window allows you to use the different shortcuts and to see the events scrolling.
To display this window, right click on the icon
click on Show

located next to the Windows time and then

From the View menu, you can choose to display shortcuts and/or events.
You can navigate through the events by clicking on the left and right arrows and choose to
remove the event from the list by clicking the Exit button.
To show or hide the icon

, click on the Display menu and then Remote control

 Tip : To hide this icon each time you start SWAMIGO3, go to the Tools menu, Preferences,
Configuration tab, then uncheck the Show remote control window at startup box.

The File menu

 From this menu, you can :
Save your installation on your PC in compressed ZIP format. Warning, this operation is not possible when
using the Windows service. In this case, use the backup menu from the installation management, or use
automatic backup (Tools menu, Preferences).
Change the manager password of the current session.
Close the session without leaving the application.
Exit the application
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The Display menu

 From this menu, you can :






Show or hide the toolbar
Show or hide the status bar
Show or hide the list of additional events (at the bottom of the main window)
Show or hide shortcuts
Show or hide the SWAMIGO3 icon in the Windows toolbar to display the Remote Control
window.

The Tools menu

Event settings

 From this window, you can:


Make a quick search for the event by entering part of the event's wording.







Sort the events in alphabetical order by clicking on
Select or deselect all events with one click
View and modify the configuration of one or more events
Reset events to default settings
Select an additional information field used for events (additional information about the user
will be added to each corresponding event). This option is only available if the field has been
previously created from the Preferences, Additional Information menu.

 From the configuration window, you can :











Configuring event acknowledgement :
o Select Yes for each selected event to be acknowledged.
o Enter the reasons that the manager can select when the event occurs. If you need to
enter more than one pattern, separate them with commas.
o Select Yes if you allow the handler to enter his or her own pattern.
Whether or not to display events in :
o The Event List (Events menu, then View list)
o The Additional List (at the bottom of the main window)
o The remote control window
o The synoptic
Whether or not to send an Email Alert to authorized managers. Attention, to use this function,
you will need to have set up the information of the email sending server from the Tools menu,
Preferences then the Emails tab.
Activate, deactivate or modify the audio sound associated with the event.
Change the colour of the event text.
Change the Event Label.
Purge the event after a certain number of days (365 by default).

Return to default configuration :
To do this, select the event(s) to be reset to the default configuration and then click Default
Configuration.

Select the items to be reset to the default settings, and then click OK.
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Favourites
Configuration tab

 From this tab, you can :
Display the remote control window when starting the software.
Display the shortcuts at software startup.
Display the list of events.
Ask for the language when starting the software.
Display and manage the ID numbers (badges, transmitters, ...) in hexadecimal.
Use the number written on the identifiers rather than the number read by our centres (useful when
the logical number is different from the physical number).
Mute the sounds as soon as the software is started.
Load the sounds on the client workstations in the case of a client/server installation (SQL SERVER
database). This function can be useful to speed up the starting of SWAMIGO3 from the client
workstations.
Activate Global Anti-Passback: useful if the installation has several input or output readers on several
IP control units. Attention, this function requires the use of the Windows service or forces SWAMIGO3
to be permanently launched on the PC.
Activate the Inputs/Outputs module allowing the inputs of a MT50000 control unit to be used to
control a SWAMIGO3 shortcut depending on their status.
Allow multiple deletion of users and identifiers. Thus a manager will be able to modify and/or delete
several users and several identifiers in a few clicks.
Allow the control of an Autinor lift.

Search for software updates when they are available. SWAMIGO3 must in this case have access to the
Internet.

Emails tab
This tab allows you to configure the emails sent by the application.
Configuration tab

 From this tab, you can enter :
The sender's email.
The SMTP server (outgoing mail) and the SMTP server port (25 by default).
Encryption (None, TLS or SSL) if the SMTP server requires it.
The authentication mode if the SMTP server requires it. In this case, enter the login and password.

Click on the Test button to send a test email. Then enter the email address of the contact to
send this test to.
Contacts tab

 From this tab, you can :
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Manage contacts receiving reports from the History and Listing tools: to add a contact, enter its email
address then click on Add To delete a contact, select it in the list then click on Delete.

Delivery Options tab

 From this tab, you choose :
To authorise the sending of mails when creating a user from the wizard.
To send an email to the authorised managers when a user is accepted on one of the selected drives.
The email sent will contain the information chosen for the user.
User tracking must be enabled in order for an email to be sent. See User management /
Options.

Additional information tab

 From this tab, you can configure up to 20 additional fields containing information about your
users. These fields will be displayed either in the Identity tab or in the Additional Information
tab of the user records.

Note: 2 additional fields Phone and Mail are present by default. It is not possible to delete these
fields.

To add a field :







Fill in the name of the field
Select the desired field type from the following choices: Text (simple text to be entered),
Multiple choice (selection between several values when entering), Check box (equivalent to a
yes/no information)
Click on Add

To change the list of values in multiple choice type fields, click the button ... as
follows:

The following window appears. Enter your choices separated by commas:

To make a field mandatory when entering user information, check the Required box.
To display a field in the identity window of a user, select the Identity Window check box.
To delete a field, select the field and click the Delete button.
Please note that the information entered in this field will be lost for all users.

Biometrics tab

 From this tab, you can :
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Activate the management of fingerprints only. Warning, before activating this function, make sure that
the country you are in allows biometrics as the only means of identifying a user.
Activate the loading of photos on the BIOMFMINI biometric readers (approximately 1 second per
photo).

Accessories tab

 From this window, you can :






Configure the number of bits managed by the MF-USB: the Mifare badge enumerator/encoder
(between 16 and 32 bits).
Choose to invert the bits read by the MF-USB.
Configure the action to be performed on presentation of an unknown badge :
Do nothing
Ask what to do. Displays the following window:

 Display a message indicating that the user is not known.
 Open the user creation wizard. See Creating users.
 Open the login creation window. See Adding an identifier
 Configuring the validity date format :
 Date and time
 Date only.
 Note : the time will still be displayed if it is different from midnight.


Activate the acknowledgement restriction. This feature allows you to filter acknowledgements
by workstation. If it is activated, each workstation (identified by its name on the network) which
should not receive all acknowledgements must be declared.

 Inthe above example : - The Poste1 computer will only send back the acknowledgements from
Reader 1.
- The Poste 2 computer will not send back any acknowledgement.
- The other computers will retrieve all the acknowledgements.
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External connection tab

 From this window, you can :










Click on Smartphone configuration to automatically set up the SWAMIGO3 web server for the
Smartphone (Android®) application.
Click on Configure Windows to configure Windows (this button does not appear on Windows
XP).
Set the IP port (8080 by default)
Select an authentication level, Highly secured, Highly secured, Secure or Unsecured
Choose an encryption key (Very High Security mode only), or click on ... to generate one.
Click on Configure smartphone to display a code to configure a smartphone directly from the
SWAMIGO3 smartphone application.

External Server: Allows the application to connect to the external server. The Identification Key
field uniquely identifies the installation on the external server.
Filter the IP addresses allowed to connect to SWAMIGO3, enter one or more IP addresses or
fill in an IP address range.

Maintenance tab

From this window, you can :


















Choose the frequency and start time for database maintenance. The maintenance performs
the requested event purging operations and the selected operations. Attention, this function
requires the use of the Windows service or forces SWAMIGO3 to be launched permanently.
Delete users whose number of passages has already been reached. The number of passages
can be set in the user's file, from the Options tab. The number of passes is configured in the
reader, from the Configuration tab.
Delete invalid users. The validity period of the user is set in the user's file, from the
Authorisation tab.
Prohibit inactive logins.
Purge the handrail: useful to lighten the database by deleting the oldest events.
Activate automatic backup. To do this, check the Enable automatic backup box.
Set the backup frequency per hour, then set the start time.
Check the time of the next backup
Force the backup, which will be made immediately when you click on OK
Fill in the backup directory. If you are using a SQL SERVER database installed on another PC,
you will have to fill in the path of a directory accessible in read/write mode by the SQL instance
and by SWAMIGO3.
Choose to export the backup to an FTP server. In this case, enter the address of the FTP server.
If the FTP server is protected, enter the login and password.
Choose to send the backup by e-mail. In this case, specify the email address of the backup
recipient. Caution: make sure to set up the mail sending server from the Emails tab and make
sure that sending large files is allowed.
Choose to send a backup report by email. In this case, specify the email address of the recipient
of this report. Caution: Make sure to set up the mail sending server from the Emails tab.
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Mifare tab

From this tab, you can configure the encoding of Mifare badges : you can then configure the
index of the first sector to be used and the encryption keys.


Attention : We advise you to specify your own Mifare keys for added security. In this
case, make a note of these keys. If you lose them, you will no longer be able to use the
already encoded badges.

SMS tab
This tab allows you to configure the SMS messages sent by the application.
 Attention : To send an SMS, an internet connection is required.
Configuration tab

 From this tab, you can :



Configure the type of SMS that is sent.
Information related to the type of configuration chosen

Click on the Test button to send a test sms. Then enter the phone number of the contact to
send the test to.
Sending Options tab

 From this tab, you choose :



Allow sending SMS when creating a user from the wizard.
To send an SMS to the authorised managers when a user is accepted on one of the selected
readers.

The SMS sent will contain the information chosen for the user.
User tracking must be enabled for an SMS to be sent. See User management / Options.

Photo/Vidéo tab

 From this tab, you can :




Select the viewing time before and after the event, from 0 to 60 seconds.
Scan photos of ID documents. Requires an ID card reader compatible with ID photo scanning.
Enable the option to crop user's photos. This option allows you to crop a photo manually added
to a user record.
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Privacy tab

 From this tab you can set the privacy level of the software :









Choose the actions to be applied when deleting a user
Delete only the user file
Making passages anonymous
Delete passages
Choose the actions to be carried out when deleting a manager.
Delete only the manager file
Making the manager's shares anonymous
Choose the time for purging movements. Default is 5 years.

Security tab

 From this tab, you can set the desired security level for passwords Interdire un mot de passe
vide




Make a minimum length compulsory
Make the presence of a lower case letter (between a and z) mandatory
Make the presence of a capital letter (between A and Z) compulsory




Make the presence of a number compulsory
Make the presence of a special character compulsory

Print templates

 From this window, you can :





Add a new model
Duplicate an existing model
Modify an existing template
Delete an existing template

To add a new template, click Add, and choose the type of template you want to create.

 From this window :




Give your print template a name
Selecting a default printer
Configure the background of the template (colour and background image)
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Select a field type and then click on

or

to add or remove a field on the preview.

When a field is selected on the preview, a configuration window opens automatically. You can
then use the Configuration menu on the right-hand side of the window.
You can move a field on the preview by clicking on it and then moving the mouse. You can also
define its position to the nearest pixel from its configuration.
The fields User photo, Last name, First name, Date, Time, Valid from, Valid to and Company
can only be added once. Their value will be automatically replaced by the user's information
when printing.
As soon as your template is finished, validate with OK.
To use your template and print a user's badge, open the user's file and go to the Print tab.
Tip: Text fields allow you to choose an alignment. Left, right, centred, none.
 This alignment is relative to the page. When you choose a manual size, the field will be
aligned within the space used by the field.
In the example below, the Last Name and First Name fields are centred with the same manual

size.

Modules management

 From this window you can activate additional modules of the software :












MOD-VISITEURS : visitor management, compatible with the use of an identity document reader
MOD-SMARTCODE : management of temporary codes that can be printed on tickets
MOD-INTRUSION : management of GALAXY HoneyWell®, BENTEL® Absoluta®, LIGHTSYS®
Risco®, or PROSYS+® Risco® intrusion units. Attention: this module requires the use of a SQL
SERVER database and the Windows service.
MOD-MORPHO : management of MORPHO biometric readers (VP Series, J Series, 100 Series,
500 Series and OMA 500 Series)
MOD-LPR : management of license plate recognition. Warning: this module is compatible with
the DIGIFORT® LPR software..
MOD-OFFLINE : APERIO offline reader management.
MOD-LECTEURS-MOBILES : management of smartphones as mobile readers for SWAMIGO3.
MOD-CHANTIERS : authorisation management for users
MOD-INTERPHONE-SIP : management of communication with an intercom using the SIP
protocol
MOD-ONLINE : management of Smart Intego and UZ add-on modules

For more information, please refer to the manuals for each module.
These modules require an additional licence which you can activate automatically (24 hours a
day, 7 days a week) if your PC has an Internet connection.
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Company management

This window allows you to manage the different companies present on your installation and who
will be able to access the software.
You will be able to assign readers, cameras and floors to each company. In this way, you will be
able to discriminate the access and configuration rights of the readers, cameras and floors for
each of them.
To enable or disable multi-company management, click on

To add a new company, click Add

, then click on Yes or No

Onglet Identité

From this tab, you can :





Fill in the name of the company and that of the manager
Enter the SIRET number and check it by clicking on Check (the PC must be connected to the
internet).
Enter a VAT number
Select a default access group

Contact details tab

From this tab you can :







Fill in the company's address
The postcode
The city
The country
The telephone number
The fax number
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Authorised Readers tab

From this tab you can select the drives to be used by the company. This means that this
company will only be able to display events occurring on authorised players, assign only
authorised players to its users, or change their settings..
The All and None buttons are used to make a quick selection or deselection of all readers.
Authorized Cameras tab

From this tab you can select the cameras that will be used by the company. This means that
this company will only be able to display and/or control authorised cameras.
The All and None buttons allow a quick selection or deselection of all cameras.
Tab Authorised floors

From this tab, you can select the floors to which access is authorised for this company in the
case of the management of one or more lifts. This means that this company will only be able to
assign authorized floors to its users.

Automatic import

This window allows you to manage the different import modules present on your installation.
You can add up to 5 import modules.
An import module allows you to import data from one or more users from the Active Directory
application or from an XML file.
To add a new module, click on Add
Settings

To activate the module, tick the Active Module box and select :




Frequency of import. You can set an import frequency from 1 second to 60 days.
The start time of the next import.
Which traces will be recorded for the import:
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Adding users
User modification
User deletion
Finally select your import format.

The Force Import option allows the data to be imported immediately after clicking OK.
Active Directory

With the Active Directory import format, you will have to fill in the following information :




The Domain Name
The Login and Password of a user with sufficient rights to consult the Active Directory of your
domain.
The type of authentication required to log on



The search filter for people. The button

allows you to reset the filter.

By checking the Delete unlisted users option, users listed in SWAMIGO3 but not listed in the
ACTIVE DIRECTORY will be automatically deleted on import.
The following fields can be imported :






Name: user name
First name: first name of the user
Group: user access group
Start of validity: date of start of validity of the user
End of validity: date of end of validity of the user







Identifiers: user's badge number
Photo: photo of the user (JPEG format), or link to a file accessible from the server.
External key: if you want to use private information as a unique user key, rather than the first
and last name fields.
Number of passages: number of passages remaining to the user.
Additional fields: You can add additional fields of information (e.g. reservation number,
location, ...). These fields must be created in the Preferences of the software.

XML

With the XML import format, you will need to fill in the location of the XML file from among
the following choices :




A physical path to a data directory
An http or HTTPS path (generally used by online booking sites)
An FTP or FTPS path (you will then need to specify a login and password if necessary)

In the case of a physical path or FTP path, select the Delete file after import option if you want
SWAMIGO3 to automatically delete the file after importing it.
In the Import Information window, fill in the various XML Tags in the corresponding fields.
The following fields can be imported :








Name: user name
First name: first name of the user
Group: user access group
Start of validity: date of start of validity of the user
End of validity: date of end of validity of the user
Identifiers: user's badge number
Photo: photo of the user (JPEG format)
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Action: action to be carried out according to the value of the field (1: modify, 2: add, 3: delete).
If this field is not filled in, users will always be added.
Additional fields: You can add additional information fields (example: reservation number,
location, ...). These fields must be created in the Preferences of the software.
External key: Allows you to synchronise data between SWAMIGO3 and an external software.
Number of passages: number of passages remaining to the user.

Sample XML file:
<?xml version="1.0" encoding="ISO-8859-1" standalone="yes"?>
<RESERVATIONS>
<RESERVATION>
<GROUPE>location1</GROUPE>
<NOM>PIERRE</NOM>
<PRENOM>STEVEN</PRENOM>
<ARRIVEE>30/07/2013 16:00</ARRIVEE>
<DEPART>31/07/2013 11:00</DEPART>
<COD>912491</COD>
</RESERVATION>
<RESERVATION>
<GROUPE>location2</GROUPE>
<NOM>OLIVIER</NOM>
<PRENOM>HENRY</PRENOM>
<ARRIVEE>10/08/2013 17:00</ARRIVEE>
<DEPART>10/08/2013 15:00</DEPART>
<COD>776085</COD>
</RESERVATION>
<RESERVATION>
<GROUPE>location3</GROUPE>
<NOM>ALEX</NOM>
<PRENOM>JACQUES</PRENOM>
<ARRIVEE>12/08/2013 14:00</ARRIVEE>
<DEPART>12/08/2013 21:00</DEPART>
<COD>620372</COD>
</RESERVATION>
</RESERVATIONS>

CSV
3 types of CSV import are possible: :




Files with comma-separated columns
Files whose columns are separated by a semicolon
Files whose columns are separated by tabs

With the CSV import format, you will need to fill in the location of the CSV file among the
following choices :




A physical path to a data directory
An HTTP or HTTPS path (generally used by online booking sites)
An FTP or FTPS path (you will then need to specify a login and password if necessary)

In the case of a physical path or FTP path, select the Delete file after import option if you want
SWAMIGO3 to automatically delete the file after importing it.
In the Import Information window, enter the column numbers in the corresponding fields.
The following fields can be imported :








Name: user name
First name: first name of the user
Group: user access group
Start of validity: date of start of validity of the user
End of validity: date of end of validity of the user
Identifiers: user's badge number
Photo: photo of the user (JPEG format)
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Action: action to be carried out according to the value of the field (1: modify, 2: add, 3: delete).
If this field is not filled in, users will always be added.
Additional fields: You can add additional information fields (e.g. reservation number, pitch, ...).
These fields must be created in the Preferences of the software.
External key: Allows you to synchronise data between SWAMIGO3 and an external software.
Number of passages: number of passages remaining to the user.

Note : To use automatic import, make sure that the server is running at all times. SWAMIGO3 or
the Windows service must always be running as well.
The use of the Windows service is strongly recommended in this case.

Automatic export

This window allows you to manage the different export modules present on your installation.
You can add up to 5 export modules.
An export module allows you to automatically export events according to numerous criteria.

From this window, you can :






Activate the export module by ticking the Active module box
Choose the frequency of export (in hours, days, or months)
Enter the date from which exports will begin
Forcing exports
Select the format of the exported file (Comma separated text, ACCESS database, Excel file, XML
file, PDF file)











Check the Compress the file check box so that the file will be compressed to ZIP format after
export.
Select a query (same as in the History menu). Please note that filters to be entered at runtime
and subtotals are not allowed.
Click on the Modify button to modify the selected query.
Click on the Add button to create a new query.
Enter the location where the file will be created. Click on ... to define this location. If you specify
a file name, this name will be used for each export. If the file already exists, it will be deleted.
If you do not specify a file name, a new file with a different name will be created for each
export.
Choose to export the file to an FTP server. In this case, specify the address of the FTP server. If
the FTP server is protected, enter the login and password.
Choose to send the file by E-mail. In this case, specify the E-mail address of the file recipient.
Caution: make sure to set up the mail sending server from the Emails tab.
Choose to delete the local file after sending by email or FTP.

Note : To use automatic export, make sure that the server is running at all times. SWAMIGO3 or
the Windows service must always be running as well.

Postponement of events
This functionality allows, for each event configured from the event settings, to carry out an

action
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From this Windows, you can :







Activate the http report.
For each event, the set URL will be called, with the event information in parameter.
Enable XML reporting
For each event, an XML file will be created and placed in the directory indicated. The
name of the file depends on the indicated parameters.
Choose the location of the generated file
Choose the number and type of file generated
Choose the information and the name that will be contained in the file.

The windows menu
This menu allows you to rearrange the windows according to the following choices:

The update menu
This menu allows you to update the control units and extension modules. Depending on your
choice, click on one of the following menus:

Updating a central unit or an extension module
Warning : these updates must be carried out by a qualified operator. We recommend that you
carry out these updates in the presence of your installer.

Select the file containing the update by using the button
Select the update mode :



.

Normal: standard update procedure
Forced: allows you to downgrade a control unit, or to restart an update of an extension module
if an attempt to update has already been made and has been interrupted.

Tick the control units or modules to be updated and then click OK.
When the updates are complete, click Cancel.

Technical menu
Central
Creating a central
The first time you start your installation, you will be prompted to create a central :
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Otherwise click on
, then on the Site Configuration menu. Then click on
Control units, then on Create a control unit.

From this window, you can :
 Create a MT50000/1 central
 Creating an MT50000/2 central
 Creating an MT50000/4 central
 Creating a BIOMF central
 Creating an MT500/1 central
 Creating an MT15000/2 central

Central MT15000/2, MT50000/1, MT50000/2, MT50000/4
Settings tab

From this tab, you can :



Give a name to your control unit: type it in the Label field.
Choose the method of communication with the central office :











MAC address: before each connection, the IP address of the control unit will be
automatically searched by SWAMIGO3. This mode allows the use of a DHCP
address on the control unit. On the other hand, it is unusable in case of remote
connection (VPN or NAT). In this case, use the IP address mode.
IP address: requires a fixed address to be configured on the control panel. This
mode is also used for remote connection (VPN or NAT) or when the UDP
protocol is blocked on the network.
DNS: Domain name or URL. This mode can be used in case of DYNDNS.

Click on the Search button to automatically detect the connected control units (if using MAC
address or IP address).
Switching off the control unit: stops all communication with this control unit.
Choose the type of connection: Local network (if your control unit is connected to the same
network) or Internet/VPN (if your control unit is accessible via an Internet connection).
Activate Anti-Pass-Back and Anti-Time-Back:



Anti-Pass-Back: This mode controls a user's pass cycle. The user must be out to
enter and vice versa.
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Anti-Time-Back: A user who has already entered will be able to re-enter after
this time (configurable between 1 and 60 minutes). The same applies to exit.
o Activate on input: the Anti-Time-Back will be active on input
o Activate on output: the Anti-Time-Back will be active on output.
o Reverse Anti-Time-Back: This function reverses the priority of the AntiTime-Back and Anti-Pass-Back functions. Even if the user exits (Anti-Passback), he will have to wait for the end of the Anti-Time-Back timer to be
able to enter again (valid on the entry and/or exit reader, depending on
the setting).

Enable transit delay: An entered user will not be able to exit if he exceeds this time.
Activate tamper protection: Check the box Tamper entry in the case in order to generate an
event when the control unit's case is open (a tamper switch must be wired on the control unit).
Then select the type of contact (NO: normally open or NC: normally closed). Check the Power
supply fault input box to generate an event when a fault occurs on the external power supply
of the control unit (a fault contact must be wired to the control unit). Select the type of contact
(NO: normally open or NC: normally closed).
Activate Password Protection: protect the control unit from any external connection attempt.

Enable Automatic Time Changeover (enabled by default): enables the automation of the
summer/winter time changeover in the control unit (last Sundays of March and October).
Activate SAS Management: prevents several doors from being opened at the same time by
users. This function can be activated permanently or in a time slot.
Activate status inversion for the Automation Relay
Set the value of the clock drift.

Operating mode tab
Note : This option is not available on MT50000/1
Note : On MT50000/4, the operating mode is to be chosen for readers 1&2 and 3&4.

From this tab, you can :




Choose operation with one reader per door
Choose operation with two readers for one door
Name the doors associated with each reader

BIOMF central
Settings tab


From this tab, you can :












Give a name to your control unit: type it in the Label field.
Fill in the IP Address or DNS
Switch off the control unit: stops all communication with this control unit.
Choose the type of connection: Local network (if your control unit is connected to the same
network) or Internet/VPN (if your control unit is accessible via an Internet connection).
Activate Anti-Pass-Back and Anti-Time-Back.
Choose the access mode to the BIOMF menu: Code or Fingerprint or Fingerprint only.
Activate SAS Management
Activate Self-protection with the possibility of using a control output available on the BIOMF
or a control output remote from a relay of the MT15000/IO extension module.

Enable Password Protection.
Activate Automatic Time Change
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4.8.1.1 Operating mode tab

From this tab, you can :








Change Sensor False Acceptance Rate (<0.01% default)
Deactivate the Buzzer
Enter the name of the Door associated with the control unit:
Activate the wiegand output and choose between 3 protocols:
Wiegand 26 bits
Wiegand 30 bit
Wiegand PRASTEL, a protocol dedicated to the MT50000 control unit whose reader type must
be set in BIOMF.

The MT50000/1 central
4.8.1.2 Settings tab

From this tab, you can :



Give a name to your control unit: type it in the Label field.
Choose the method of communication with the central office :













MAC address: before each connection, the IP address of the control unit will be automatically
searched by SWAMIGO3. This mode allows the use of a DHCP address on the control unit. On
the other hand, it cannot be used in case of remote connection (VPN or NAT). In this case, use
the IP address mode.
IP address: requires the central unit to be configured with a fixed address. This mode is also
used for remote connection (VPN or NAT) or when the UDP protocol is blocked on the network.
DNS: Domain name or URL. This mode can be used in case of DYNDNS.
Switch off the control unit: stops all communication with this control unit.
Choose the type of connection: Local network (if your control unit is connected to the same
network) or Internet/VPN (if your control unit is accessible via an Internet connection).
Activate Anti-Pass-Back and Anti-Time-Back.
Activate Self-protection: with the possibility of using a control output available on the control
unit or a control output remote from a relay of the MT15000-EXTIO extension module.

Activate password protection
Activating the automatic time changeover

4.8.1.3 Operating mode tab

From this tab, you can :



Choosing operation with a reader and a door
Name the doors associated with each reader

Extension modules
Create an extension module
To add a plug-in, click Plug-ins and then click Add plug-in as follows:
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Module MT15000-EXT4 et MT50000-EXT4
4.9.1.1 Settings tab

From this tab, you can :




Give a name to your module: type it in the Label field.
Enter the module ID: this can be found on a label stuck on the module (example: ID: 00051).
Activate the self-protection with the tamper input on the box or the power supply fault.







Select the behaviour of the degraded mode among the following choices :
Deactivate the push button: the push button will no longer function in this mode.
Refuse all identifiers (no badges will be accepted)
Check the site code (only badges with authorised site codes will be accepted)
Switch to sustained opening (blocks open doors)


This mode comes into effect 30 seconds after communication with the control unit is
interrupted.
Attention, in degraded mode, no event will be recorded by the module.
4.9.1.2 Tabs Readers 1 & 2 and Readers 3 & 4

From this tab, you can :




Choose operation with one reader per door
Choose operation with two readers for one door
Name the doors associated with each reader
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Module MT15000-EXTIO

From this window, you can:
- Name your module: enter the name in the "Name" field.
- Define the module's identifier, which can be found on a label affixed to the module
(e.g. ID: 00051).
- Specify the tolerance of the four-state inputs (if applicable) between 0.20V and 1.20V.
- In fail-soft mode, enable / disable all outputs or maintain the previous status.

This mode becomes effective 30 seconds after a communication failure with the
MT50000 central unit.
From the "Inputs" tab, you can:
-

Name the module inputs: enter the name in the "Name" field.
Enable the Four-state mode.
Force the input to Enabled or Disabled.

From the "Outputs" tab, you can name the module outputs: enter the name in the "Name"
field.

V-EXTLCD Module

From this window, you can:






Name your module: enter the name in the "Name" field.
Assign a value from 1 to 255 seconds for the display stand-by feature.
Enable the cleaning code (9999): by entering this code, the keypad will be locked for 30
seconds so that it can be cleaned.
Define the module's identifier, which can be found on a label affixed to the module
(e.g. ID: 00051).
Choose the default screen:



o Touch button.
o Keypad.
o Keypad (rolling code).
o Menu 1, 2, 3 or 4.
Name the menus and buttons: enter the name in the "Name" and "Buttons" fields.
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Each button is configured with one or more automatic devices that will need to be created.

APERIO®Reader

From this window, you can:



name your reader
Activate or disable reader.

4.9.1.3 Configuration tab
From this tab, you can:





Enter the reader's address.
Enable the "Anti-passback" function and choose whether the reader is for an entry or exit.
Enable the maximum number of users per group.
Enable the passage count function.




Enter the delay of opening.
Define the number of bits for Mifare/Destfire badges
o Reverse: allows you to indicate that the badge number is reversed for a 32- or 56-bit
badge
Specify whether the shell is an Apério V3



4.9.1.4 Free Access time range & Mode tab

From this tab, you can:






Set the free access range for each security level
o Select “None” to apply no free access to the reader
o Select a time range so that the reader will remain opened until the selected range
will remained active
o

Click "Add a time Range" to create a new time range

o

Click "See time range" to edit the selected time

The free access time range (if selected) will only start until a user will be accepted
Enable office mode
Select the operating mode for 3 security levels
o Either continuous monitoring, or
o Opening maintained, or
o Closure maintained.
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4.9.1.5 Badge + code tab

From this tab, you can:



Enable the badge + code function.
Enter a predefined code request time range.



Authorise users without a code.

Smart Intego Reader
This module requires an additional MOD-ONLINE license

From this window, you can name your reader: enter the name in the "Name" field.
4.9.1.6 Configuration tab
From this tab, you can:






Enter the Gateway node address.
Enter the reader's address.
Enable the "Anti-passback" function and choose whether the reader is for an entry or exit.
Enable the maximum number of users per group.
Enable the passage count function.





Enter the delay of opening.
Define the number of bits for Mifare/Destfire badges
Activate wake mode in short period.
Note: This option allows more frequent communication with the module, but significantly
reduces battery life.
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4.9.1.7 Free Access time & Mode tab

From this tab, you can:


Set the free access range for each security level
o Select “None” to apply no free access to the reader
o Select a time range so that the reader will remain opened until the selected range
will remained active
o





Click "Add a time Range" to create a new time range

o Click "See time range" to edit the selected time
o Start free access at the first accepted user.
Select the operating mode for 3 security levels
o Either continuous monitoring, or
o Opening maintained, or
o Closure maintained.
Activate and consult whitelist.

From this window, you can set the read type (CSN, Setup 1, Setup 2, Setup 3, Setup 4) based
on the configuration of your cards, and add the different credentials to be authorised.
4.9.1.8 State of Door tab

From this tab, you can:




Choose to monitor the state of the door
Select the name of the door.
Enable tracking logs

4.9.1.9 Keyboard tab
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From this tab, you can:



Link a keyboard to the module
Select the keyboard address.

UZ Module
This module requires an additional MOD-ONLINE license.

From this window, you can:



Name your reader
Activate or disable this reader.

4.9.1.10 Configuration tab

From this tab, you can:





Know the address of the module on the hub.
Activate "Anti-Pass-Back" and select whether the reader is input or output.
Activate the maximum number of users per group
Activate pass count





Set the open time
Define the number of bits for Mifare/Destfire cards
View the remote control status.
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4.9.1.11 Open Access Time slot & Mode tab

From this tab, you can:




Set the open access time slot for each security level (requires remote activation - see
Activating remote opening)
o Select "None" to not apply open access to the reader
o Select a time slot to keep the reader open as long as the selected time slot is active
o Click on "Add a time slot" to create a new time slot
o Click on "View time slot" to edit the selected time slot
o Choose to only begin open access to the first accepted user
o Activate office mode
Select the Operating Mode for the three security levels
o Either ongoing control
o Or hold open
o Or hold closed

4.9.1.12 Module Configuration
To access the configuration menu, click "Configure" on the technical page.

Orders

From the "Orders" tab, you can:





Pair the module
Unpair the module
Activate remote opening
Disable remote opening

Pair the module
Note: a programming card must be presented before the order is launched.
Enter the module's serial number, then click the "Pair" button

Confirm the confirmation window.
Unpaire the module
Note: no card is needed to launch the order.
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Click on “Unpair”.

Confirm the confirmation window.

Activate remote opening
Note: a card must be presented in front of the module after the order is launched.
Click on “Activate”

Confirm the confirmation window.
Disable Remote opening
Note: a card must be presented in front of the module after the order is launched.
Click on “Disable”

Confirm the confirmation window.

MIFARE card Configuration

From the "MIFARE card" tab, you can:


Select the action to perform for MIFARE cards









Define the key to use for reading
Select the sector number
Select the block number
Select the beginning of the file
Select the length of reading
Define the reading key
Update the module with the new settings
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DESFIRE Configuration card

From the "DESFIRE card" tab, you can:


Select the action to perform for DESFIRE cards



Define the type of encryption to use









Select the application ID
Select the file number
Select the key number
Select the beginning of the file
Select the length of reading
Define the reading key
Update the module with the new settings

4.9.1.13 Whitelist
Note: a card must be presented in front of the module after the order is launched.
To access the whitelist configuration menu, click "Configure whitelist" on the technical page.

From this window, you can:



Add usernames to the whitelist
Confirm the whitelist

V-EXTINT Module
This module allows you to control a LIGHTSYS RISCO® intrusion unit. It requires an additional
license MOD-INTRUSION.

From this window, you can:


Name your module: enter the name in the "Name" field.
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Define the module's identifier, which can be found on a label affixed to the module
(e.g. ID: 00051).

To add a zone, click on "Zones" and click "Add Zone". You can add up to 8 zones per module.

From this window, you can give a name to your zone and set its position. You can also check
its status.
To add a group, click on "Groups" and then click "Add Group". You can add up to 4 groups.

From this window, you can name your group, set its position, check its status and enable
automatic start:





At a time range
With a delay before starting:
o Instantaneously
o From 1 to 255 minutes
With an extension time
o Without delay (Instant service)
o From 1 to 255 minutes: allows to report the automatic start if a user is accepted on a
reader

Automatic Devices
To add an automatic device, click on "Automatic devices" and then "Create an automatic
device" as follows:

In the Automatic device window, you can:








Name your automatic device: enter the name in the "Name" field.
Disable the automatic device.
Add up to four conditions associated with an "AND" or "OR" logical operator.
Add up to two actions, which will be executed when the conditions are true.
Add up to two opposing actions, which will be executed when the conditions are false.
Choose to send an email to all managers authorized to receive alerts when the device starts
Choose to send an email to all managers authorized to receive alerts when the device stops

Adding a condition
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From the "Condition" window, you can select the type of condition:



For a "Range" condition, select the time range to be tested and then select its status
(enabled or disabled).





For an "Input" condition, select the input to be tested (only those in the MT50000 central
unit) and then select its status (enabled or disabled).

For an "Input" condition, select the input to be tested (only those in the MT50000
central unit) and then select its status (enabled or disabled).



For an "Automatic device" condition, select the automatic device to be tested and then select
its status (enabled or disabled).



For an "Event" condition, select the type of event to be tested.

Depending on the type of event, you can add an additional condition, such as:
o
o
o
o
o

The choice of reader on which the event occurs.
The number of the identifier relating to the event.
The group of the user relating to the event.
The menu of a VEXTLCD relating to the event.
The code entered on a VEXTLCD relating to the event.



For a "Counter value" condition (displayed if a counter is created), select the counter to be
tested and the test method (if the value is lower than / greater than or equal to / equal to)
and then enter the value to be compared.



For a "Security level value" condition, select the test method (if the current security
level is lower than / greater than or equal to / equal to) and then enter the value to be
compared.
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For a "Time" condition, select the test method (if the current time is lower than /
greater than or equal to / equal to) and then enter the value to be compared.



For a "Date" condition, select the test method (if the current date is lower than / greater than
/ equal to) and then enter the date to be compared.



For a "Door" condition, select the door to be tested and then select its status (Closed or
Open).



For a "Lobby" condition, select its status (Closed or Open).

Adding an action

From this window, you can select the type of action:



For an "Output" action, select one of the outputs of the MT50000 central unit and then
choose Enable, Disable or Enable during (1 to 65534 seconds).



For an "External output" action, select a relay for a V-EXTIO module and then choose Enable,
Disable, Invert or Enable during (1 to 65534 seconds).



For a "Group" action, select the group and then Authorise or Prohibit.
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For a "Reader" action, select the reader and choose one of the following operating modes:
o Normal mode.
o Opening (delay).
o Opening maintained.
o Closure maintained.
o Closure.



For a "Counter" action, select a counter and then Increment, Decrement or Reset.



For a "Reset anti-passback" action, you can:
o Clear the anti-passback cycle for "All users".
o Clear the anti-passback cycle for all "The users in the group" and then select the
group.

Caution: To execute this action, SWAMIGO3 must be running on your computer.


For a "Security level" action, select:
o Increment the security level.
o Decrement the security level.
o Switch to security level 1, 2 or 3.



For "Control an LED", select:
o The reader on which to control the LED
o The new colour of the LED: Normal, Off, Blue, Red or Green.

Note: only OSDP, SSCP and S33/R33 readers of the control unit can be controlled.

Counters
To add a counter, click on "Counters" and then "Add a counter" as follows:

From the counter window, you can:



Change the "Name".
Enter a value between 0 and 65535.
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Analogue Inputs
To add an analogue input, click on "Analogue inputs" and then "Add an analogue input" as
follows:

The analogue input is associated with a V-EXTIO module that first needs to be created in
SWAMIGO3.
In the "Analogue input" window, you can:






Change the "Name".
Choose the input associated with the V-EXTIO module.
Choose a conversion formula.
Choose a unit of measurement.
Enter a time value for reading the analogue input between 1 and 360 seconds.

The analogue input has a conversion range between 0V and 5V.
The converted value can then be displayed in the overview plan.

LCD Messages
To configure the messages displayed on the VEXTLCD modules, click on "Messages" and then
"Modify" as follows:

In the "Messages for LCD module" window, you can enter 32 messages of up to 32 characters
each.
These messages can be displayed using an automatic device.

Online Automatic Devices
Online automatic devices are only available in case of using a client / server installation (SQL
database) with the Windows service. Under another type of installation, these devices do not
appear. They are only managed by SWAMIGO3. So make sure that the server machine is
constantly running.
To add an automatic, click on "Online Automation" and then "Create an automatism" as
follows:

From the window of the automatic device, you can:
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Give a name to your device: Type in the "Name" field
Disable the device
Add up to four conditions associated with an "AND" or "OR" logical operator.
Add up to two actions, which will be executed when the conditions are true.
Add up to two opposing actions, which will be executed when the conditions are false.
Choose to send an email to all managers authorized to receive alerts when the device starts
Choose to send an email to all managers authorized to receive alerts when the device stops

4.14.1.1 Adding a condition :

From the "Condition" window, you can select the type of condition:







An event
A value for a counter
A value for security
A time
A date
System status

4.14.1.2 Adding an Action :

From the "Action" window, you can select the type of action:


Drive an external VEXT-IO output










Grant/deny an access group
Drive a reader
Change the value of a counter
Reset the users anti-passback cycle
Change the security level
Display a message on a MOD-AFF module
Execute a HTTP query
Reload users number of passages

For more information about the parameters, see chapter “Automatic devices” above.

Zones Management
The zones management allows you to locate users. For this, you can either edit a user's record
or consult the “Present user management” (available from the “Users” menu”).
To add a zone, click on "Zones" and then "Add a zone" as follows:

Parameters tab

From this tab, you can:



Name your zone
Start a maximum attendance time if a user exceeds the specified time, an alert is displayed in
SWAMIGO3.
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Define an email alert when attendance time is exceeded.

Access tab

From this tab, you can select the readers as entry and exit of the zone, and reader dependant
of the zone.
Dependant readers are readers that require presence in zone to pass, but do not change user’s
zone status after pass.
You can also place an icon on the overview in order to see the number of people in each zone
in real time.

Video Servers
Creating a video server
To create a video server, click on "Video servers" and then "Create a video server" as follows:

From this window, you can:



Name your server: enter the name in the "Name" field.
Choose the server manufacturer:
o DIGIFORT (requires activation of the MOD-VMS licence)





o SAMSUNG
o DAHUA
o NUUO
o MILESTONE (requires activation of the MOD-VMS licence)
o HIK
o GIGAMEDIA
Enter the server's address (URL).
Modify the port
Modify the port for video playback



Click on the "List cameras" button to detect all the cameras on the video server.




Enter the login for your server.
Enter the password.

Then you will be able to view the cameras video from a shortcut or video matrices.

Creating an IP Camera
To create an IP camera, click on “Video” / “IP Cameras” then on “Add” as illustrated below
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4.16.1.1 Configuration tab

From this tab, you can:




Select the name of the camera.
Specify an RTSP address for the camera.
Specify whether or not the camera is deactivated.

4.16.1.2 Associed Sources tab

From this tab, you can:


Select the associated sources (readers, LPR readers, Groups intrusion and Zone intrusion)
which will enable you to display the video from this camera for acquittal.

4.16.1.3 PTZ tab

From this tab, you can:




Define whether or not the camera handles the PTZ.
Specify whether an authentication is required to move the camera
Define the different RTSP channels required to move the camera

Camera Setting
To configure a camera, click on “Modify” from a camera, as indicated below:
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4.16.1.4 Configuration tab

From this tab, you can:




Select the name of the camera.
Specify an RTSP address for the camera. This address will enable you to access the camera
from the Smartphone App.
Specify whether or not the camera is deactivated.

4.16.1.5 Associed Sources tab

From this tab, you can:


Select the associated sources (readers, LPR readers, Groups intrusion and Zone intrusion)
which will enable you to display the video from this camera for acquittal.

4.16.1.6 Registration Events tab

From this tab, you can:


Select one or more types of events for triggering the video.

To watch the video according to an event, display the list of events (“Events” then “See
Events”) and click the camera image in front of the desired event. A window will open and you
will be able to watch the video.
Caution: this feature only allows to view a video from a recorder. SWAMIGO3 will never trigger
the video recording on the recorder. This recorder will have to be configured accordingly
(permanent recording, motion detection ...).
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4.16.1.7 PTZ tab

From this tab, you can:




Define whether or not the camera handles the PTZ.
Specify whether or not stocker authentication is required to move a camera in RTSP
Define the different RTSP channels required to move the camera from the Smartphone App.

Creating a video matrix
To create a video matrix, click "Video Servers" and then "Video Matrix" as follows:

From this window, you can:


Add a new matrix by clicking the "Add" button



Modify an existing matrix by selecting the desired matrix and clicking "Modify"



Delete an existing matrix by selecting the desired matrix and clicking "Delete"
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4.16.1.8 Configuring a video matrix

From this window, you can:





Give a name to your matrix
Change the number of cameras to display in the matrix (1, 4, 9 or 16)
Create or delete pages
Show or hide the configuration menu

To add a camera, select it in the right list and drag it into an available slot (gray rectangle).
To remove a camera from the current page, click the button on the camera top right corner
and then click "Close" as follows:

If your camera is motorized, click the button on the camera top right corner, then click
"PTZ" as follows:

Then use the arrow and magnifiers to control your camera.
To hide the controls of the camera, click again on the button in the upper right corner, then
click "PTZ".

To view a camera in full screen, click the button in the upper right corner of the camera and
click "Full Screen" as follows:

To return to the normal display, click again on the button in the upper right corner and click
"Full Screen".
Tip: You can use a shortcut to display your matrix.

Configuring a central unit reader
From the Technical menu then Site configuration, click on the central unit reader then
"Modify":

From this window, you can:



Name your reader: enter the name in the "Name" field.
Disable the reader (it will no longer be taken into account in the calculation of the license).

4.17.1.1 Configuration tab
In the Configuration tab, you can:
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Choose the Type of reader:
o Clock & Data
o Personalised Clock & Data
o Deister Clock&Data
o DIGIT MINI EXT
o Digitouch
o OSDP (HID)
o Personalised Clock & Data
o Personalised decimal Wiegand
o Personalised Wiegand
o PROEM Clock&Data receiver
o Reader with keypad (HID RK40)
o S33/R33 keypad reader (STID)
o S33/R33 reader (STID)
o Signal S
o SSCP (STID)
o Wiegand
o Wiegand 26 bits
o Wiegand 30 bits
o 32-bit Wiegand
o Wiegand 37 bits
o Wiegand 37 bits decimal
o Wiegand 56 bits
o Multiformat Wiegand
o Wiegand ACC-ER-KR60x
o Wiegand decimal
o Wiegand keypad
o Wiegand Prastel
o Wiegand Vauban Systems
o Zomofi



Enable the Anti-passback function by selecting the reader either as an "Input" or an "Output".

Check the "Manage the maximum per group" box if you wish to restrict the number of users
per access group for a given reader. The maximum number is specified in the group - refer to
the chapter entitled "Managing access groups".
Enable passage confirmation to validate when users operate a reader. To use this function,
the "Door contact" input must be connected to a door contact and the parameter for the input
must also be enabled; refer to the "Opening command and inputs" tab.


Enable the passage count function. You can select:

o
o
o



Test: used to test the number of times that a user has operated a reader without
counting and block the user if the reader is equal to 0.
Test and count: used to test the number of times that a user has operated a reader
by counting and block the user if the reader is equal to 0.
Daily count: enables count 1 time per day.

Enable Lobby mode: used to integrate a reader into a lobby. Only one of the readers
belonging to the lobby can be enabled at any one time.

4.17.1.2 Opening Command & inputs tab

From this tab, you can:


Configure the Opening command.
o If you check the "End of command on door opening" box (a door contact needs to be
connected to the central unit's "Door Contact" input), the relay command will be
disabled when the door is opened or the time delay expires.
o If you check the "Authorise access group delay" box, the reader's relay command
delay will correspond to the delay specified in the group, which is practical if the time
required for a user to operate a reader is long.
o The relay command delay is from 1 to 255 seconds. If you set the value to less than 1,
you will switch to Bistable command mode (the relay status is reversed for each user
accepted or each press of the pushbutton).
o The LED output (generally used to control the reader's LED) may follow the:
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Opening command (status of the command relay).
Door state (status of the "Door contact" input).
Opening command and door status (statuses of the command relay and
"Door contact" input).





Configure the Pushbutton input.
You can choose:
o Between a NO or NC contact.
o Continuous operation or a predefined time range.



Configure the Door contact input.
You can choose:
o Between a NO or NC contact.
o The blocked door delay function creates a blocked door event in SWAMIGO3 if the
door is not closed within the predefined time.
Configure the Conditional input.
You choose:



o

o

NO or NC vehicle detection
When a badge is swiped at the reader, a vehicle must be detected to confirm the
opening command.
NO or NC alarm in service
When a badge is swiped at the reader, users will be refused entry unless they have
been assigned the alarm management authorisation.

o

o

Glass break monitoring green NO or NC
This will create a simple event in SWAMIGO3 for enabling or disabling the break-glass
functionality.
NO or NC thermal camera.
this will create a simple event in SWAMIGO3 on thermal alert.

4.17.1.3 Alarm badge tab

From this tab, you can:





Enable the "Alarm badge" function.
Enter the number of passages (between 1 and 10) for the badge at the reader to enable the
alarm.
Specify a delay to reach the number of passages required to enable the alarm.
Choose the command:
o By the Automatic device relay.
o By the Automatic device open collector output.
o By a MT50000/EXTIO module relay.






Set the bistable or pulse command delay to a value between 1 and 255 seconds.
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4.17.1.4 Hosts tab

From this tab, you can:



Enable the visitor user management function.
Select a predefined hosting time range.



Set a delay for waiting for the host after the visitor user.

4.17.1.5 Free access time & Mode

From this tab, you can:






Set the free access range for each security level
o Select <Permanent control> to apply no free access to the reader
o Select a time range so that the reader will remain opened until the selected range
will remained active
o

Click "Add a time Range" to create a new time range

o

Click "See time range" to edit the selected time

Start free access at the first accepted user.
Enable office mode
Select the operating mode for 3 security levels
o Either continuous monitoring, or
o Opening maintained, or
o Closure maintained.

4.17.1.6 Badge + Code tab

From this tab, you can:





Enable the badge + code function.
Select the keypad associated with the reader.
Set a delay for the code waiting time (between 1 and 255 seconds) after a badge is swiped at
the reader.
Enter a predefined code request time range.



Authorise users without a code.
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4.17.1.7 Autinor lifts tab
Note: This tab only requires one declared Autinor lift to be displayed (see Managing Autinor
lifts)

Via this tab, you can:





Specify whether the reader controls an Autinor lift.
Choose the Autinor lift controlled by the reader.
Choose the floor where the reader is located.
Choose the order of the reader corresponding to its position in the corridor.

Advanced reader parameters
Depending on the type of reader selected, you can apply advanced settings to the reader.

Wiegand Keypad

From the advanced configuration, you can choose the type of keypad (Wiegand 26 or 30 bits)
and set the keypad lock (from 1 to 255 seconds) depending on the number of incorrect codes.

Clock & data Reader

From the advanced configuration, you can configure the number of read characters (5 to 10
characters).

Personnalised Clock & Data

In the advanced configuration, choose the number of characters returned by the reader (10
to 128 characters) and then enter the following parameters:





Number: location and size of the badge number read (maximum of 10 characters).
Site code: location and size of the site code (maximum of 5 characters).
Distributor code: location and size of the distributor code (maximum of 5 characters).
Channels: location and size of the channels (maximum of 5 characters) for the radio emitters.
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By clicking on "Configure site codes",
you can add authorized site codes:

By clicking on "Configure distributor
codes", you can add authorized distributor
codes:

To configure each item, select them in the list and then check the corresponding box in the
"Enable" column. Finally, in the frame, click on each character concerned. Caution: characters
for the same item must be consecutive.

In the Channels tab, you can choose the value of each channel for each reader (between 0
and 255).

By clicking on "Automatic detection", you can automatically search for the area containing
the badge number in the frame received from the reader.
To start the search, enter the badge number to be read by the central unit and then click on
"Start". You will then have 15 seconds to present the badge at the selected reader.
If a match is found between the number entered and the number read, after clicking on
"OK", the
reader type will automatically be configured.

DEISTER Clock & Data Reader

The configuration procedure is the same as for a personalised Clock & Data reader.
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Digit Mini EXT Reader

From the advanced configuration, you can:
4.18.1.1 Interface tab






Activate or disable Buzzer.
Select colours and lighting levels
Define box intrusion detection values.
Choose to allow black card.

4.18.1.2 Biométrics tab





Define when biometric prints on cards should be checked
Define biometric sensitivity
Reset reader ID in the event of a replacement.

Reader with keypad (HID RK40 or other equivalent product)

From the advanced configuration, you can:





Select the type of keypad: 4 or 26-bit Wiegand.
Lock the keypad for 1 to 255 seconds following 1 to 10 incorrect codes.
Select the type of reader

OSDP Reader (HID)
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From the advanced configuration panel, you can:




Activate or disable Buzzer.
Select colours and lighting

S33/R33 Keypad Reader (STID)

From the advanced configuration panel, you can:
4.18.1.3 Parameters tab




Activate or disable Buzzer.
Select colours and lighting levels

4.18.1.4 S33/R33 tab






Specify encryption key
Specify position of card number
Define card number size
Configure keyboard blocking in case of wrong code

S33/R33 Reader (STID)

From the advanced configuration panel, you can:
4.18.1.5 Parameters tab
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Activate or disable Buzzer.
Select colours and lighting levels

4.18.1.6 S33/R33 tab





Specify encryption key
Specify position of card number
Define card number size

SSCP Reader (STID)

The configuration mode is identical to that of the OSDP reader (HID).

Wiegand Reader

In the advanced configuration, you can choose the number of bits to be received by the central
unit (16 to 32 bits).

Wiegand 26 bits Reader

From the advanced configuration, you can enable the site code management function. Click
on "Configure site codes" to add the authorised site codes.

Wiegand 30 bits Reader

In the advanced configuration, you can:


Enable the site code management function. Click on "Configure site codes" to add the
authorised site codes.



Enable the distributor code management function. Click on "Configure distributor codes" to
add the authorised distributor codes.
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Wiegand 32 bits Reader

From the advanced configuration panel, you can reverse the badge number.

Wiegand 56 bits Reader
The configuration mode is identical to that of the 32-bit reader.

Wiegand decimal Reader

In the advanced configuration, you can choose the number of bits to be received by the central
unit (16 to 32 bits).

Personalised Decimal Wiegand

In the advanced configuration, choose the number of bits returned by the reader (16 to 128
bits) and then enter the following parameters:





Number: location and size of the badge number read (maximum of 32 bits).
Site code: location and size of the site code (maximum of 16 bits).
Distributor code: location and size of the distributor code (maximum of 16 bits).
Channels: location and size of the channels (maximum of 16 bits) for the radio emitters.

You can also:






Configure the authorised site codes.
Configure the authorised distributor codes.
Perform an automatic detection.
Configure the channels for each reader.
Configure the parities as follows:

Personalised Wiegand

The configuration is the same as for a personalised decimal Wiegand reader.

Multiformat Wiegand Reader
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From the advanced configuration panel, you can choose the formats that will be authorized
on the reader, as well as the related site codes

The different authorized formats are:










Wiegand 26 bits
o 16-bit badge number
o 16-bit badge number, with site code
o 24-bit badge number
Wiegand 30 bits
o 16-bit badge number
o 16-bit badge number, with site code
o Prastel format
Wiegand 32 bits
o Activate or not the reversal of the badge number
Wiegand Vauban Systems
o Activate or not the verification of the site code
Wiegand 37 bits
o Hexadecimal badge number
o Decimal badge number
Wiegand 56 bits
o Activate or not the reversal of the badge number

By clicking on "Auto Detect", you can automatically search for the format of the badge
presented in front of the reader.

Wiegand personnalised Reader

The configuration is the same as for a personalised decimal Wiegand reader.

Wiegand PRASTEL Systems Reader

Wiegand VAUBAN Systems Reader

In the advanced configuration, you can enable the site code management function. Click on
"Configure site codes" to add the authorised site codes.

Note: this type of reader is dedicated to the HID iClass® readers associated with HID badges.
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Zomofi Reader

From the advanced settings, you can:




Select tag timeout
Select attenuation value

Display Modules Management
These modules allow you to display information on a screen. A HDMI connection is mandatory
on the screen.
To add a new module, click "Display modules" and then "Create a display module" as follows:

From this window, you can:






Give a name to your module, type it in the "Name" field
Configure the IP address or DNS address of your module
Search your module on the network
Disconnect the module: stops all communication with the module.
Set a password: the password is used to prevent access to the module's configuration by
another computer




Set the resolution of the screen connected to the module (in pixels)
Configure the update frequency (from 1 to 65535 minutes) if you display dynamic lists (eg
past events, present list ...)

To configure the display, click your module then click "Set display" as follows:

The following window appears:

It is possible to add several sequences, configure each display time as well as each mode of
transition (fade from left to right or box by box).
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For each sequence, you can:


Change the time: Present the mouse cursor over the right edge of the preview until a double
arrow appears. Then move the mouse to the desired length.







Add a text
Add a date and time
Add a picture (example: display the logo of the company)
Add a user’s picture (example: wish a colleague birthday)
Display the result of SQL query on the database (examples: last events, list of user present in
a zone, personalized query without any limitation). Caution: if you use this type of display,
SWAMIGO3 will manage the update of the displayed datas. In this case, ensure SWAMIGO3
will always run on your computer.

To add an item, select it in the list on the right and drag it on the sequence.
You can move an item in the sequence by clicking on it and then moving the mouse over the
sequence.
To configure an item, select it on the sequence and then change its settings from the list on
the right bottom of the window.

To remove an item, change the display order, or change the alignment, right-click the item
and click the desired.
Please note that the updated data from the dynamic lists will be managed by SWAMIGO3. In
this case, make sure SWAMIGO3 is constantly running on your computer.

Using the Windows service is highly recommended in this case.

Example of sequence:

Example of personalised query:

Personalised SQL query :

Pre-parametered query :
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Please note that the updated data from these dynamic lists will be managed by SWAMIGO3.
In this case, make sure SWAMIGO3 is constantly running on your computer.
Using the Windows service is highly recommended in this case.

Lifts Management
The lifts are managed by the MT50000/EXTIO extension modules. These must be declared
before you can set up your lifts.
To add a lift, click "Lifts" and then "Create a lift" as follows:

The following window appears:

From this window, you can:





Give a name to your lift: type it in the "Name" field
Select the reader associated to the lift
From the "Outputs used" tab, select the relay that will be used to activate the buttons in the
lift: use the arrows for it
From the "free accesses" tab, set the free access to each floor as follows:
o No free access: the floors will only be released when a user is accepted

o

Free access on all relays: the floors will be released until the selected time range will
remain active.
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Also you can edit the selected time range by clicking “See time” or add a new time range by
clicking “New time range”.
o

Different free access on each relay: you can set a free access time range for each
floor.

Also you can add a new time range by clicking “Add time range”.
Then you will be able to grant users access on each floor using the access groups.

Autinor Lifts Management
In order to manage Autinor lifts, the function must be activated in the Preferences/Functions
menu.
An Autinor lift is an electronic interface card between the software and one or more physical
lifts.

Adding an Autinor Lifts
To add an Autinor lift, click on “Lifts” and then on “Create an Autinor lift”

The following window is displayed:

Via this window, you can:







Name your lift – enter this in the Label field.
Set the IP address and port number of the interface card.
Disconnect the lift.
Choose the number of floors.
Choose the life signal frequency.
Name each floor.

Note: each reader must be configured before it can control lifts (see Configuring a reader from
the centre / Autinor lifts tab)
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Note: the authorisations must be configured based on access groups (see Managing access
groups / Autinor lifts tab)

5 Schedules & Access Groups Menu
Managing Time Ranges
From the menu, click on

Time Ranges.

The list of time ranges is displayed.
Click on "Add" to add a new time range.
Click on "Modify" to modify the selected time range.
Click on "Delete" to delete the selected time range.
5.1.1.1 Time Range Management :

In this window, you can:



Name your time range. Caution: the name must be unique (the same name cannot be used
for more than one time range).
Configure the type of display:
o Every day: if your times are different every day.
o Monday to Friday / Weekend: if your times are identical from Monday to Friday, but
different at the weekend.
o Monday to Sunday: if your times are identical from Monday to Sunday.
o Monday to Saturday/Sunday: if your hours are the same from Monday to
Saturday, but different on Sunday.



Enter your schedules
o Graphic entry



Adding a time slot: click in a red area and hold down the left mouse button
while moving the pointer until the required time slot is obtained.



Modifying a time slot: click on the time slot and move it. You can also

double-click on a time slot and then click on "Modify to enter schedules
manually" .



Deleting a time slot: click on the time slot and then press the "Delete" key
on your keyboard or double-click on the time slot and then click on the

"Delete" button.
o

Manual entry:



Adding a time slot: click on an empty time slot, enter your times in the
"Modifying the selected time slot" area and then click on the "Apply" button.



Modifying a time slot: click on the time slot to be modified , enter your new
times in the "Modifying the selected time slot" area and then click on the

"Apply" button.
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Deleting a time slot: click on the time slot to be deleted and then click on
the "Delete" button.

For each time range, you can define a day of the week as well as choose from a list of public
holidays.
To configure the list, click on the
button after "Public holidays". A new window is
displayed where you can configure the list of public holidays.
You can also define another list of specific days. To do so, click on the "Add a list" option
from the drop-down menu:

Management Public Holidays
From the menu
holidays is displayed.

, click on Public Holidays. The list of public

In this window, you can:


Add renewable public holidays (automatically renewed from one year to the next by the
central units and software). To do so, select "Renewable" and then click on the days that you
wish to add. These days will then take the selected colour.



Add non-renewable public holidays (automatically deleted at the end of their validity period).
To do so, select "Non-renewable" and then click on the days that you wish to add. These
days will then take the selected colour.



Delete public holidays: select "Delete" and then click on each day that you wish to delete.



Delete all public holidays: click on the "Delete daily" button.



Import public holidays from Outlook: automatically import public holidays from your Outlook
calendar. Caution: to use this function, Outlook 2007 or earlier must be installed on your
computer.

Managing Special Days
In addition to special days, you can add up to eight additional lists of special days.
From the menu
displayed.

, click on Special Days. The list of special days is

Click on "Add" to add a new list of special days.
Click on "Modify" to modify the selected list.
Click on "Delete" to delete the selected list.
5.3.1.1 Managind a list

From this window, you can:



Name your list (in the "Name" area).
Add, modify and delete days according to two formats (Day/Month/Year or
Day/Month/Year/Hours/Minutes).

Managing Access Groups
From the menu
displayed.

, click on Access Groups. The list of groups is
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Click on "Add" to add a new group.
Click on "Modify" to modify the selected group.
Click on "Delete" to delete the selected group.
Click on "Export" to export the configuration report:

Managind an Access Group
5.4.1.1

Information tab

From this tab, you can:






Name your access group.
Determine your group's status: check the "Prohibit group" box to refuse all users belonging to
this group.
Choose an opening delay which will replace the reader setting. To do this, uncheck the box
“Use reader delay” then set the new opening delay.

Restrict the number of accesses for group users to the readers. You can choose the counter
that will be used (the group counter or a counter previously created on the unit). If you use
the group counter, you can change its current value by clicking on the button "Modify

counter value" and entering its new value.

5.4.1.2 Authorisations tab

From this tab, you can select the readers to which you want to grant users access. Doubleclick on a reader in the left-hand list (list of prohibited readers) to authorise it or doubleclick on a reader in the right-hand list (list of authorised readers) to deny access. You can
also use the arrows in the centre of both lists to switch the selected readers.
A display filter is also available, to display only the readers matching the filter.
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5.4.1.3 Schedules tab

From this tab, you can define access schedules on the readers authorised for your group. In
particular, you can:




Choose to not restrict the access schedules for your users.
Define identical access schedules on all readers: to do so, select or create a time range.
Configure different schedules on each reader: to do so, select a time range opposite each
reader.

5.4.1.4 Lifts tab

If you manage lifts and if a reader associated to a lift is granted in the group, a new tab with
the name of your lift appears.
Then you can select the floors to which you want your users to be granted. Double click on
one floor of the left list (list of prohibited floors) to authorize or double click on a floor of
the right list (list of authorized floors) to prohibit it. You can also use the arrows in the
center of the two lists to toggle the selected floors.

5.4.1.5 Autinor lifts tab

Via this tab, you can:




Choose access type (Normal or President).
Choose authorised floors.
Choose a favourite floor by right-clicking it.

Exporting the Access Groups Setting
To export your group access configuration, from this group list, click on “export” button

From this window, you can:



Choose to include the configuration of the groups in the report by checking the "Group
Configuration" box.
After generating the report:
o Export it.
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o



Email it to a contact selected in a list or enter the contact directly with the option of
zipping the file. This option depends on the email settings in Tools > Preferences >
Emails.
o Print it.
Choose the format for the report:
o Text (.txt).
o Comma-separated text (.csv).
o Access 2007 (.accdb).
o Excel (.xls).
o XML (.xml).
o PDF (.pdf).

6 Users Menu
Creating Users
The first method for creating users involves using a wizard, which will create the identifiers
(badges, emitters, application badges, and so on), users (physical people accessing the site)
and access groups (schedules and access rights for the site's different readers).

To do so, click on

and then Creating users.

The following wizard is displayed:

There are three different ways to enter your identifiers:
 Manual entry: enter the first number of your identifiers, the quantity to be created, the
identifier type and the status, and then click on "Next".
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 Generation of random codes: chooses the quantity of codes to be created and the number of
digits, and then click on "Generate". Finally, click on "Next".



Learning: click on "Learning" and then pass your identifiers one-by-one to any reader in your
installation. If you have a DIGIUSB (Mifare CSN card reader), swipe your badges one-by-one.
Select the type of identifier and the status, and then click on "Next".

Enter the access rights to be created for your users (authorisations for the site's different
readers).

To do so, you can:




Use an existing access group (caution: this option is only available if groups have already been
created in your installation).
Grant users access to all readers.
Grant users access to a selection of readers: the list of all readers will then be displayed, and
you must check the readers to which users will have access.

Then click on "Next":

Enter the access schedules for your new users. To do so, you can:





Use the schedules for the selected access group: if you have chosen an existing access group,
your only option will be to use the schedules for that group.
Choose to not restrict the access schedules for your users.
Define identical access schedules on all readers: to do so, select or create a time range.
Configure different schedules on each reader: to do so, select a time range opposite each
reader.

Then click on "Next":

Enter the different options for your users:







Their status (Authorised or Suspended).
The "Alarm management" option: users authorised to activate / deactivate an alarm system
connected to the central unit (your installation must already be correctly configured).
The "Without checking cycle" option: if your installation is configured to use the Antipassback function and this box is checked, all users created with this option will not be
subject to the Anti-passback mechanism.
The "Anti-passback forgiveness" option: whenever users operate a reader, all anti-passback
cycles for all users will be cleared (all users can enter or exit again).
The "Limit the number of passages to" option will restrict a user's maximum number of
passages to the value entered.
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The validity start and end dates.

Then click on "Next":

Use this window to choose the identity type of each user: common or separate identity.
Then click on "Next":

Use this window to define user identities. To proceed to the next step, all fields marked with
* must be filled in.
Then click on "Next":

Ensure that all the information displayed is correct. If the wizard needs to create a new
access group, you can change its name. Then click on "Confirm" to finish creating your users.

Managing Identifiers
To display the list of identifiers (proximity cards, application tag, transmitters, codes, …), click

on "Identifiers" in the menu.

From this window, you can:




Search for an identifier by entering the number in the box “Identifier”
Select the type of identifiers to display
Select if you want to display only the attributed identifiers, not attributed identifiers or both



Press “Add” to create a new identifier



Press “Modify” to edit an identifier



Press “Delete” to delete an identifier



Press "Export" to export the list of identifiers

Adding an Identifier
From the previous menu, press “Add”
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From this window, you can:






Enter the number of the first identifier
Enter the quantity of identifiers to create in case of several identifiers
Select the type of the identifiers
Select the status
If you use an Omnikey USB reader, swipe the first card in front of the reader

Note: The identifiers created using this window do not have attributed user. That means you
have to create users then select the appropriate identifier for each of them. If you want to
create identifiers and users at a time, use the “Create users” menu.

Modifying an Identifier
From the identifiers list, select the identifier to modify then press “Modify” or double click
on it.

From this window, you can:




Select the type of the identifier
Select the status
Enter the logical number: if the number written on the identifier is different than the read
number. To enable this option, press “Display numbers written on identifiers” from the




“Favorites” menu.
Attribute or not the identifier to an user
Edit the user (if the identifier is attributed)



Press OK to save the configuration.

Deleting an Identifier
From the identifiers list, select the identifier to delete then press “Delete”.
Confirm the deletion then confirm if you want to delete the according user (if the identifier is
attributed).
If you have authorized multiple modification of identifiers from the “Favorites” menu, the
following window appears by pressing “Delete”:
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From this window, you can:






Delete only the selected identifier
Delete all identifiers at a time
Delete all identifiers matching with the number and quantity entered
Delete all identifiers according to the selected type
Delete all identifiers unattributed

Press OK, confirm the deletion then confirm if you want to delete the according user (if the
identifiers are attributed).

Export the Identifiers
From the list of identifiers, click on "Export".

From this window, you can





Export the list of identifiers to a file
Email the list of identifiers
Print the list of identifiers
Choose the operating format of the report:
o Text (.txt).
o Comma-separated text (.csv).
o Access 2007 (.accdb).
o Excel (.xls).

o
o

XML (.xml).
PDF (.pdf).

Managing Users
To display the list of users, click on "Users" in the menu

.

From this window, you can:


Search for an user by entering his last name or first name or press “Search” for more criteria



Press “Add” to create a new user



Press “Modify” to edit an user



Press “Delete” to delete an user



Press “Modify several users” to modify several users. To enable this option, check the box
“Authorize multiple modification of users and identifiers” from the “Favorites” menu.

Adding or Modify a user
To add a user, press “Add” from the previous window.
To modify a user, you must first open his record.
To find a user, click on "Users" in the menu
.
The list of users is displayed. Double-click on one of the users in the list or click on
to find a user based on their last name, first name or identifier.
The user's record is then displayed:
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Tip: at the bottom of the window, you will see information about the user's presence
(Unknown if your site has not implemented the anti-passback function or if the user has not
yet operated one of your site's readers, in or out, the date of his last passage and the zone in
which he is if you manage the zones).
6.3.1.1 Identity tab
From this tab, you can:



Configure a last name and first name for your user.
Add an image file that has already been saved on your computer or network.
If you’ve already activated the “Crop” option in settings, an intermediate window will open
enabling you to select what part of the photo to keep.



Take a photo using a webcam connected to your computer.



Delete the user's photo.

If you click on "Take a photo", the following window is displayed:

Select the required webcam from the list in the top-left corner. Click on the "Capture"
button to take a photo. Finally, when the photo suits you, click on "OK".
6.3.1.2 Identifiers tab

From this tab, you can:


Add new identifiers to your user (for example, your users can use an emitter to access a car
park and a badge to access their office). You can assign as many identifiers to the user as
required (maximum of 15,000). Caution: the same identifier cannot be assigned to more than
one user. Click on the "Add" button. The list of identifiers (only those that have not yet been
assigned) is displayed. Then double-click on the identifier that you wish to assign to the
user
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Modify an already assigned identifier: select an identifier in the list and then click on

"Modify" . You can then modify the type of identifier (proximity badge, etc.) and the status


(In service, Suspended or Stolen).
Remove an identifier from your user: select an identifier in the list and then click on

"Delete" .
6.3.1.3 Authorisations tab

From this tab, you can:







Select the user's status (Authorised or Suspended).
Configure the access schedules:
o Group range (use the schedules configured in the access groups).
o Permanent access: no schedule restrictions for all readers, regardless of the
schedules configured for your access groups.
o Predefined time range: use this time range for all readers, regardless of the time
ranges configured for your access groups.
Configure the validity start and end dates and times.
Configure start and end dates and times for temporary bans. A user who is temporarily
banned cannot access the site during the specified period
Configure the access groups:
o

Add a group from those already created: click on the "Add" button. The list of groups

o

is displayed. Double-click on the required access group . You can add up to three
access groups for the same user.
Modify the access group selected in the list.

o

Delete the selected access group.

o

See authorized readers:

It is possible to display the readers in groups, and to filter the displayed readers.
6.3.1.4 Additional Informations tab

From this tab, you can add other types of information to your user (e.g. telephone number,
parking space, etc.). To add new fields, use the "Preferences" menu from the “Tools” menu
at the top of the software's interface.

143

6.3.1.5 Movements tab

In the "Movements" tab, you can see the user's last 50 passages. The first line in the list
corresponds to the most recent passage.

6.3.1.6 Options tab

From this tab, you can modify the different options for your user:








The "Alarm management" option: users authorised to activate / deactivate an alarm system
connected to the central unit (your installation must already be correctly configured).
The "No anti-passback monitoring" option: if your installation is configured to use the Antipassback function and this box is checked, all users created with this option will not be
subject to the Anti-passback mechanism.
The "Anti-passback forgiveness" option: whenever users operate a reader, all anti-passback
cycles for all users will be cleared (all users can enter or exit again).
Number of passages: users will have a restricted number of passages for the readers
configured to support this function.
Option “Track this user” enables you to send an email and/or an SMS to managers if the
feature was activated in the settings. Cf. Email preferences and SMS preferences.
The "This user must have a host" option: on readers configured to support this function, users
must be accompanied by a specific user or a user belonging to an access group in order to be
authorised. Check this box and then choose the type of host:

o

"User": click on "Search" and then double-click on the host in the list displayed.
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o

"User group": click on "Search" and then double-click on the host access group
(any user belonging to the selected access group can accompany the user).



The "This user must swipe badge then enter this code" option: on readers configured to support this
function, users must enter the specified code.



The "Do not acknowledge this user’s events” option: the acknowledgment window will not be
displayed for this user
The "Office mode management" option: allows the user to manage office mode on
configured readers.





6.3.1.7 Printing tab

In the "Printing" tab, you can select:




The predefined printing template. Refer to "Badge printing templates".
A printer.
An identifier.

To finish, click on:


“Send by email” to send the card as an attachment to an email



“Print” to print the card.

6.3.1.8 Biometrics tab

From this tab, you can:



Choose the enrolment module (click “Set as default module” to remember the used
module)
Encode a card with or without fingerprints



Enrol the user’s fingerprints (to activate this function, use the “Preferences” menu if you are
sure to be allowed to use fingerprints only in your current country)

Deleting Users
From the users list, select the user to delete then press “Delete”.
Confirm the deletion then confirm if you want to delete the according identifiers (if the user
owns one or more identifiers).
If you have authorized multiple modification of users from the “Favorites” menu, the following
window appears by pressing “Delete”:
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From this window, you can:





Delete only selected users
Delete all users
Delete all users without identifier
Delete users belonging to a group

Press OK, confirm the deletion then confirm if you want to delete the according identifiers (if
the user owns one or more identifiers).

Modifying Several Users at a time
From the users list, press “Modify several users”. This option is only available if the box
“Authorize multiple modification of users and identifiers” is checked from the “Favorites”
menu.

From this window, you can:












Choose to only edit selected users
Select the groups of users to modify
Select to replace the ten groups of the corresponding users
Select to replace the status of the corresponding users
Select to replace the time zone of the corresponding users
Select to replace the number of passages of the corresponding users
Replace the company of the corresponding users
Select to replace the validity dates of the corresponding users
Replace the cycle verification of the corresponding users
Replace the acknowledgment of events of the corresponding users
Replace the office mode management of the corresponding users

Press OK to modify all users according to selected group(s).
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Warning: this operation cannot be undone.

User Privacy
This function makes it possible to anonymise the traces of deleted users in accordance with
European personal data protection regulations.
In the User list, click on “Privacy”.

Via this window, you can:



Set the user’s surname.
Set the user’s forename.

Validate the action by clicking on “OK”. SWAMIGO3 will display a confirmation request.
Confirm the modification by clicking on “Yes”.
Warning: this action cannot be undone and it has an impact on the results of history searches.

Customer List of Users
You can generate user lists by configuring the fields to be displayed and filtering according to
different criteria.

To sort a list, click on "Listing" in the menu.
displayed:

The following window is

From this window, you can:


Add a query: click on the "Add" button and then configure your query.



Modify a query: select your query in the list and then click on the "Modify" button.



Delete a query: select your query in the list and then click on the "Delete" button.



Execute a query: select your query in the list and then click on the "Execute" button. The
results will then be displayed.
Export the results of a query: after executing a query, select a format in the list (text file,
comma-separated text, Access 2007 database, Excel, XML or PDF) and then click on the



"Export" button.


Send the query results by email: after executing a query, select a format in the list (text file,
comma-separated text, Access 2007 database, Excel, XML or PDF) and then click on the

"Send by e-mail" button. Select or enter a recipient and choose whether to zip the file.
Caution: to use this function, you must have configured the email settings in the software's
"Preferences" menu.


Print the query results: after executing a query, click on the "Print" button.



Open the selected user's record by double-clicking on it or by clicking on the "Modify"
button in the bottom-right corner if shortcuts are displayed (to show or hide shortcuts, click
on the "Shortcuts" button).

151

Managing a query
Display tab

From this tab, you can:




Name your query: enter the name in the "Name" field.
Check the fields that you wish to display in the list.
Note that additional fields can be selected provided that they have previously been added via
Tools > Preferences > Additional information.





Use buttons
and
to change the order in which the result columns are displayed.
Select a sort for the results.
Check the "Generate subtotal" box to generate a subtotal depending on the selected sort
criteria.

Filters tab

To filter the users to be displayed, click on the "Filters" tab. In this tab, you can define the
following filters:













By last name: filter users whose last name starts with / ends with / contains your text.
By first name: filter users whose first name starts with / ends with / contains your text.
By group: filter users whose group is part of your list.
By time range: filter users whose time range is part of your list.
By status: filter users whose status matches the selected status.
By validity start and end date: filter users whose validity dates are later than / earlier than /
between the dates entered.
By credentials: filter users with specific credentials.
By presence: filter users whose presence matches the presence selected.
By Alarm, Forgiveness, Password confirmation (without any anti-passback cycle check),
Visitor, and With biometrics: filter users whose options match the options selected.
By number of passages: filter users whose passages are equal to / greater than or equal to /
less than a number or between two numbers.
By the presence of biometric data: filter users according to whether they have been enrolled.
By number of passages: filter users whose number of passages is equal to / greater than or
equal to / less than or between the values entered.
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By inactivity: filter users who have not logged in for a while
By acknowledgment: filter users for which the acknowledgment window will or will not be
displayed
By Office mode management: filter users with or without Office mode management.
By presence of a photo: filter users based on whether or not their credentials have a photo.
By authorised readers: filter users according to the authorised readers.
If you have defined additional fields: filter users whose information starts with / ends with /
contains your text.

To add a filter, simply check it. A new window is displayed, where you can fine-tune your
search criteria.
To modify a filter, go to the list of filters (at the bottom of the window) and click on the blue
link (example:
). A new window is displayed, where you can fine-tune your search
criteria.
To delete a filter, simply uncheck it.
To filter users by last name or first name, check the "Ask on execution" box, so that the
software prompts you to enter your text when executing the query.
Once you have entered your filters, click on "OK". In the previous window, click on
"Execute". The results will be displayed.

Reset Users Anti-PassBack
To reset all users anti-passback cycle, click "Reset anti-passback" as follows:

Click "Yes" when prompted.
The current presence of all users will be erased and they will be able to go in or out again.

Importing a list of users
To import a list of users, click "Import a List" as follows:

The following window appears:

To import your list, click "Import Data" and then select your data type:


From the clipboard: you must first have copied data



From a file: Then select your file format and click "Open". The following formats are
available:



From a database:


o



Select the format of the database (ACCESS or SQL SERVER)
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o
o
o
o

Enter the path to the database
Enter the authentication mode, the login and password if necessary
Specify the query to retrieve the data to import
Use the "Settings" button to export or import the configuration

Once your data is imported, you must configure the various columns as follows:

For each field type to import, configure the column number based on the data in your file. If
your file does not contain some columns, leave them as "Undefined".
Tip: You can import multiple credentials per user. To do this, in the identifier column, enter the
list of user IDs separated by commas.
To return at any time on this column settings, click "Modify Columns".
To remove the lines you do not want to import, select them from the list and click "Remove".
To start importing and creating users, click "Confirm Import".
If you have set a "Group" column, make sure that the access groups were created previously
with the same spelling. You can then choose whether to create non-existent groups.
Otherwise, you can choose an access group that will be automatically assigned to all imported
users.
These last two options will be required upon confirmation of import.

Presence Time
To calculate the user presence time, click "presence time" as follows:

The following window appears:

From this window, you can:





Select the entries and exists readers. You can also use the shortcuts "All" and "None" to check
or uncheck all readers within one click.
Select the calculation period: month predefined or custom period
Select users to calculate either the users of all groups, users of a group or a specific user
View the details of the user passages by checking the box "Display passages"



Start the calculation by clicking on "Calculate"



Export results: after running the calculation, select a format from the list (text file, text
separated by commas, Access 2007 database, Excel, XML or PDF) and click the "Export"



button.
Send results by email: after running the calculation, select a format from the list (text file, text
separated by commas, Access 2007 database, Excel, XML or PDF) then click "Send by e-

mail". Select or enter a recipient and choose whether to compress the file. Caution: to use
this feature, you must have configured the mail settings from the "Preferences" menu of the
software.


Print the results: after running the calculation, click the "Print" button

Managingthe present user
To view the list of users in one or more areas, click "Present user management" as follows:
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To use this feature, you must have configured your areas first.
The following window appears:

From this window, you can:


Select the areas used for the report. You can also use the shortcuts "All" and "None" to check
or uncheck all zones in one click.



Start the calculation by clicking on "Calculate"



Export results: after running the calculation, select a format from the list (text file, text
separated by commas, Access 2007 database, Excel, XML or PDF) and click the "Export"
button
Send results by email: after running the calculation, select a format from the list (text file, text
separated by commas, Access 2007 database, Excel, XML or PDF) and then click "Send by email". Select or enter a recipient and choose whether to compress the file. Caution: to use
this feature, you must have configured the mail settings from the "Preferences" menu of the
software.
Print the results: after running the calculation, click the "Print" button
Select to generate a subtotal per area in the report by checking the box "Generate one
subtotal per area"
Select the sort criterion of users by selecting it in the list (Name or Access Group)







7 Proximity History
This feature allows you to search for users who have swiped on the same reader in a close
interval, or who have spent time together.

From this window, you can:


Select the type of search to perform and choose the readers or the zones.

From this window, you can:


Seach the user at the origin of the search.
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From this window, you can:


Choose the search period.

From this window, you can:


Choose the interval needed.

From this window, you can:


Export the search results.

Events Menu
You can display a list of events in real time at the bottom of your screen by clicking on the
"Display" menu and then "Event list".

Caution: this list only contains events that have occurred since you started SWAMIGO3. To
close the list, click on the "Close" button at the top-right of the list.

To view the last 2,000 events, click on the menu
Note: to display more events, refer to the "History" tool.

and then "See list".

The following window is displayed:
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In this window, you can:


View the last 2,000 events.



Double-click on a user-related event to open its record.
Double-click on an identifier-related event to open its record.




Consult a recorded video (requires compatible video server and a setup of SWAMIGO3
according to the recordings, refer Video Servers section)

Events History & Reports
You can sort the event history by configuring the fields to be displayed and filtering
according to different criteria.

To sort the history, click on "History and reports" in the menu
following window is displayed:

. The

In this window, you can:


Add a query: click on the "Add" button and then configure your query.



Modify a query: select your query in the list and then click on the "Modify" button.



Delete a query: select your query in the list and then click on the "Delete" button.



Execute a query: select your query in the list and then click on the "Execute" button. The
results will then be displayed.



Export the results of a query: after executing a query, select a format in the list (text file,
comma-separated text, Access 2007 database, Excel, XML or PDF) and then click on the

"Export" button.


Send the query results by email: after executing a query, select a format in the list (text file,
comma-separated text, Access 2007 database, Excel, XML or PDF) and then click on the

"Send by e-mail" button. Select or enter a recipient and choose whether to zip the file.
Caution: to use this function, you must have configured the email settings in the software's
"Preferences" menu.


Print the query results: after executing a query, click on the "Print" button.



If the selected event concerns a user, open the record by double-clicking on it or by clicking
on the "Modify" button in the bottom-right corner if shortcuts are displayed (to show or
hide shortcuts, click on the "Shortcuts" button).



If the selected event concerns an identifier, open the record by double-clicking on it or by
clicking on the "Modify" button in the bottom-right corner if shortcuts are displayed (to
show or hide shortcuts, click on the "Shortcuts" button).

Managing a query
Display tab
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From this tab, you can:



Name your query: enter the name in the "Name" field.
Check the fields that you wish to display in the history.





Use buttons
and
to change the order in which the result columns are displayed.
Select a sort for the results.
Check the "Generate subtotal" box to generate a subtotal depending on the selected sort
criteria.

Filters tab

To filter the events to be displayed, click on the "Filters" tab. In this tab, you can define the
following filters:





By date: filter events whose date and time is later than / earlier than / between the dates
entered.
By time: filter events whose time is between the times entered.
By type: filter events whose type is part of your list.
By central unit: filter events whose central unit is part of your list.









By Associated Source: filter events to view events from your list of Associated sources
(Readers, LPR server, Groups intrusion, Zones intrusion).
By identifier: filter events whose identifier is part of your list.
By last name: filter events where the last name starts with / ends with / contains your text.
By first name: filter events where the first name starts with / ends with / contains your text.
By group: filter events whose group is part of your list.
By Acquittal date, by Cause, by Manager
By additional information (if this feature has been activated in the “Event Configuration”
menu).

To add a filter, simply check it. A new window is displayed, where you can fine-tune your
search criteria.
To modify a filter, go to the list of filters (at the bottom of the window) and click on the blue
link (example:
). A new window is displayed, where you can fine-tune your
search criteria.
To delete a filter, simply uncheck it.
To filter users by last name or first name, check the "Ask on execution" box, so that the
software prompts you to enter your text when executing the query.
Once you have entered your filters, click on "OK". In the previous window, click on
"Execute". The results will be displayed.

DayBook Menu
From the menu, click on

“Daybook”.

From this window, you can:


Add a new entry: Click on “ New entry ”.
For further information, Cf. chapter “Adding an entry”



Define categories: Click on “ Categories ”.
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For further information, Cf. chapter “Category management”
Select display filters: you can filter categories, managers or entry severity
Select display period: select the period during which the desired entry took place.



Display results: click on “ View ” to show the entries matching the selected criteria



Export displayed results: once you have displayed results, select a format from the list (text
file, CSV file, Access 2007 database, Excel, XML or PDF) then click on “ Export ”



Send displayed results by email: once you have displayed results, select a format from the list
(text file, CSV file, Access 2007 database, Excel, XML or PDF) then click on “ Send by email ”
Select or type a recipient, and specify whether or not to compress the file. Note: In order to
be able to use this feature, you need to have configured the email settings in the
“Preferences” menu of the software.



Print query results: once the results are displayed, click on “ Print ”

Adding an entry
From the “Daybook” window, click on “New entry”.

From this window, you can:






Specify the title of the event
Select the date at which the event took place
Select the category of the event
Select the severity of the event
Add an attachment when applicable: the attachment must not exceed 1Mo.

Category Management
From the “Visitors” window, click on “Categories”.

From this window, you can:


Add, modify or delete categories.

8 Maps Menu
The overview allows you to view your installation's status in real time and in plan format.

Editing the Maps
From the menu

select “Edit” to create your maps.
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Your overview must have a plan. The first time, you are prompted to add a plan via a specific
window or click on Add in the left-hand column and then search for a plan in jpg, bmp, gif or
png format.
To add items to a plan, select the item in the list of items on the right side of the window
and drag into the plan.
In the plan, you can right-click on the icon to see a preview of the item's different
statuses or delete the item.
By selecting an icon in the plan, you can edit its parameters in the lower part of the righthand column.

For a reader, you can:




Choose a background colour.
Show or hide an event window as soon as an event occurs
on the reader.
Select the window position:






Change the image size.
Change the image.
Change the name.
Change the font.

Opening the Maps
From the menu

select “Open” to open your maps.

If you have several plans, you can select the required plan in the left-hand column:

9 Administration Menu
The administration function is used to organise the software's managers. You can then adjust
the access rights for each manager. A log is also available and provides a record of all events
occurring between the start and end of a given session.

Creating a manager
In the menu

click on Managers.

You can add, duplicate, modify and delete managers. The Administrator is the default
manager and cannot be modified or deleted, since the Administrator represents the top-level
manager.
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Click on "Add" to create a manager.

From this window, you can enter the:






Last name.
First name.
Email address.
Phone number
Password.

Check "The password may be changed" to allow managers to change their password.
Check "The password must be changed" to force managers to change their password when
opening a session.
Check "Manager prohibited" to ban the manager.
Check "Manager using the SmartPhone application" to allow managers to use the iPhone
application (if this function is enabled).
Check "Receive e-mail alerts" so that managers will receive events by email. An email address
must be provided.
Check "Operator able to acknowledge" to indicate that the acknowledgment window may be
displayed for this operator.
Check "Enable default window" to choose a window to open when logging in.

All managers have rights determining their access and management of the software. To
configure their rights, go to the "Rights" tab.

From this window, you can check all of the following columns with a single click:




Complete control: managers have no restrictions and complete access to all software
functionality as the administrator.
Read only: managers have access to all software functionality, but cannot make any changes
to the software.
Rejected: managers will be denied access to all software functionality and all their rights will
be deleted.

You can also reorganise managers' rights if they are not part of the same column. The rights
available are as follows:


Technical
o Site configuration
o Equipment status
o Central unit management
o Reader management
o Automatic device management
o Counter management
o Security level
o Lifts management
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o Video server management
o Video matrices management
o Zones management
o Display modules management
Schedules and access rights
o Time ranges
o Public holiday management
o Lists of special days
o Access groups
Users
o Identifiers
o Users
o User privacy
o User movements
o User creation
o List of users
o Re-cycle users
o Data import
o Attendance time
o Present user management
o Proximity history
Events
o Event display
o History and reports
o Daybook
Maps
o Edit the maps
o Open the maps
Administration
o Managers
o Managers log
Updates
o Units, extension modules and software updates
Tools
o Event settings
o Card printing templates
o Preferences
o Modules management
o Company management
o Automatic import
o Shortcuts management
o Event report
Software management
o Software closure

If you have additional modules, you will also find the different access rights to these modules
in this window.

You can limit the control or acknowledgment on the readers. To set these permissions, go to
the "Readers" tab

Check "Limit access to different readers" to filter the actions of this operator.
For each reader, you can indicate:
- If the operator can control the reader; in this case, it the reader can be opened from
a synoptic, for example.

-

If the operator can acknowledge the reader: the acknowledgment window will be
displayed for this reader.

10 Managing a Shortcut
Shortcuts provide a very quick way of using the software both easily and effectively. You can
carry out pre-programmed tasks with just a single click.
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Create a Shortcut
In the right-hand column, click on

to create a new shortcut:

From this window, you can:




Change the name.
Choose the type of shortcut.
Modify, delete or reset the shortcut image.

Shortcut Configuration

From this window, you can:






Modify a shortcut
Warning, changes apply to all managers
Delete a shortcut
Warning, deletions apply to all managers
Move a shortcut up or down
Hide shortcuts that you are not going to use.

Warning, Modify and Delete buttons apply to all managers. Up/Down/Hide buttons apply only
to the current Manager.

Types of Shortcut
1. Open a window: with this shortcut, you can open the following functions:











Site configuration
Equipment status
Time ranges
Public holidays
Special days list
Access groups
Identifiers
Users
User creation
User list












Event list
History and report
Edit overview
Overview
Presence time
Managers
Security level
Data import
Video switcher
Attendance management

2. Create: with this shortcut, you can create:







A group.
A time range.
A list of special days.
An identifier.
A user.
A manager.
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3. Creating users: from this shortcut, you can open the user creation window.
4. History: with this shortcut, you can execute a predefined query in the Event history. This shortcut
enables you to:






Display the results.
Print the results.
Export the results in the following format: Text (.txt), Comma-separated text (.csv), Access (.accdb), Excel (.xls)
XML (.xml), PDF (.pdf).
Define the location of the results on your PC.
Email the file to a recipient. The file can be zipped and/or deleted after sending.

5. User list: with this shortcut, you can execute the same operations as the History, and the query must be
predefined in the Listing.
6. Control readers: with this shortcut, you can control one or more readers:







Simple opening
Return to Normal mode
Opening maintained
Closure maintained

The command can be executed on all readers or just specific readers.

7. Search for a user: with this shortcut, you can display the following window:



In this window, you can select one of the following search criteria:
o
o
o



Last name
First name
Identifier

Then click on "Search". In case of search results, you can double-click on users to edit them.

8. Video servers: with this shortcut, you can Display a camera that has been selected in a list or a Global
event from a Digifort video server that has been pre-declared in your site's configuration.
9. Launch a program: with this shortcut, you can launch another program on your PC. To do so, define the
path pointing to the program.
10. Force the importing of a module: with this shortcut, you can automatically import a module. To do so,
first configure the settings in Tools > Automatic import.
11. Drive an output: with this shortcut, you can control the output for a V-EXTIO module relay. The
command is either to enable the relay or disable the relay.
12. Change security level: with this shortcut, you can change the software security level. You can choose
between security levels 1, 2 and 3.
13. Force automatic export: with this shortcut, you can automatically export a module. To do so, first
configure the settings in Tools > Automatic export.
14. Set the display of a module: with this shortcut, you can set the display of a module that has been
selected in a list.
15. Manage daybook: display list or add new entry
16. Drive an input: with this shortcut, you can execute the same operations as the “Drive an output”.
17. Force database maintenance: starts the database maintenance process, without waiting for noon or

midnight.
18. Present user management: Allows you to start displaying, exporting or printing the presence user list
for a specific area, by generating or not a sub-total per aera.

11 Appendices
List & Version of SDK integrated in SWAMIGO3
Video stocker model
Dahua
Digifort
Gigamédia
Hik
Milestone
Nuuo
Samsung (Hanwha)

SDK version
V 3.4.4
V 7.0 or V7.2.1
V 1.0.44
HCNetSdk V 5.3.5.25
EngineManager V 3.8.0.3
V 3.1
V 1.44.0

SQL Server compatibility
SWAMIGO3 is compatible with the following SQL server versions:
SQL server version
SQL Serveur 2008
SQL Serveur 2012
SQL Serveur 2014
SQL Serveur 2016
SQL Serveur 2017
SQL Serveur 2019

Windows version needed
Windows 7 SP1 or higher
Windows 7 SP1 or higher
Windows 7 SP1 or higher
Windows 8.1 or higher
Windows 8.1 or higher
Windows 10 or higher

Number of Device
Type of equipment
Zones
OnlineAutomation
Elevators
Units
ModulesExtension
Automation
Meters
Analog Inputs
Video ServersVideo
Central Intrusion
ZonesIntrusion
GroupsIntrusion
ServerLPR
ModulesDisplay
OfflinePlayers
BeachesOffline
MobileReaders

Maximum number
254
72
32
256 (64 in Access base)
10 per control unit MT50000/2
64 by MT50000/2 control units
32 per unit MT50000/2
4 per unit
10
Depends on the registered license
Depends on the type of intrusion station
Depends on the type of intrusion control
unit
20
5
Depends on the registered license
14
Depends on the registered license

SIP intercoms
Parking
Perimeter Modules

Depends on the registered license
Depends on the registered license
Depends on the registered license

